Работа в окне проекта 

· 4.1. Атрибуты MIDI-трека. Использование MIDI-эффектов и VSTi 

· 4.1.1. Атрибуты MIDI-трека, доступные из списка треков 

· 4.1.2. Атрибуты и параметры MIDI-трека, доступные в поле инспектора; редактирование барабанной карты; применение MIDI-эффектов 

· Основная секция инспектора MIDI-трека 

· Секция Track Parameters 

· Секция Inserts, подключение MIDI-эффектов 

· Секция Sends 

· Секция Channel 

· 4.1.3. Подключение VSTi 

· 4.2. Атрибуты аудиотрека 

· 4.2.1. Атрибуты аудиотрека, доступные из списка треков 

· 4.2.2. Атрибуты и параметры аудиотрека, доступные в поле инспектора; применение аудиоэффектов реального времени 

· Основная секция инспектора аудиотрека; немного о пространственном панорамировании 

· Секция Inserts 

· Секция Equalizers 

· Секция Sends 

· Секция Channel 

· 4.3. Назначение и атрибуты групповых треков 

· 4.4. Секция треков 

· 4.4.1. Части (parts), первое знакомство 

· 4.4.2. Шкала времени Ruler, указатель текущей позиции, расширенные функции управления воспроизведением проекта и изменение масштаба отображения графических объектов секции треков 

· 4.4.3. Запись MIDI и звука 

· Подготовка MIDI- и аудиотреков к записи 

· Способы переключения программы в режим записи 

· Режимы записи, циклическая запись, регионы аудиосообщений 

· 4.4.4. Привязка графических объектов, первое знакомство с квантизацией 

· 4.4.5. Операции над частями и аудиосообщениями 

· Выделение 

· Удаление, отмена последней операции 

· Перемещение 

· Разрезание 

· Склеивание, заполнение пауз 

· Копирование 

· Инструмент Range Selection 

· Амплитудные огибающие аудиосообщений; пересечение аудиосообщений, Auto Fades, Auto Crossfades 

· Перемещение границ частей и аудиосообщений, алгоритм Time Stretch 

· Мьютирование и блокирование частей и аудиосообщений 

· 4.5. Операции над треками 

· 4.6. Треки-контейнеры 

· 4.7. Трек маркеров (Marker Track) и все, что с ним связано 

· 4.8. Автоматизация 

· 4.8.1. Запись автоматизации 

· 4.8.2. Формирование и редактирование огибающих автоматизации 

· 4.8.3. Автоматизация MIDI-треков 

· 4.8.4. Автоматизация аудиотреков и групповых треков 

· 4.8.5. Автоматизация VSTi и аудиоэффектов, мастер-секции микшера 

· 4.9. Атрибуты объектов проекта, поле Infoline 

Окно проекта Cubase SX Project (рис. 4.1.) можно считать основным окном. Именно этим окном вам придется пользоваться чаще всего. В Cubase SX одновременно может быть открыто несколько проектов. В заголовке окна каждого из проектов отображается имя файла проекта. Если же проект не был сохранен в файле, вместо имени файла будет присутствовать надпись untitled. 
За понятием "проект" стоит нечто большее, чем просто окно. В проекте задействованы ресурсы программных и аппаратных устройств, которые настроены определенным образом именно под этот проект. И в то же время в Cubase SX одновременно может присутствовать несколько проектов. Как же быть с аппаратными ресурсами, являющимися общими для всех проектов? Проблема разделения ресурсов между проектами в Cubase SX решается следующим образом: проектов может быть много, но активным может быть только один из них. Активному проекту полностью принадлежат все ресурсы виртуальной студии. В некоторых музыкальных редакторах (например, SONAR) активным является тот проект, окно которого активно. В Cubase SX активный проект назначается нажатием безымянной кнопки, расположенной в левом верхнем углу окна Cubase SX Project. У активного проекта эта кнопка окрашена в красноватый цвет, у неактивного — в серый. 
Окно включает в себя следующие составляющие. В верхней части окна располагается панель инструментов, в числе которых есть и кнопки управления записью/воспроизведением проекта, которые частично дублируют функции транспортной панели. 
Под панелями инструментов располагается информационная строка (Infoline), в которой отображаются параметры выбранных объектов проекта. Кроме того, отображаемые в информационной строке параметры доступны для редактирования. Скрыть или отобразить информационную строку можно с помощью кнопки 
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Рис. 4.1. Окно Cubase SX Project (не создано ни одного трека)
Как видно из рис. 4.1, вся остальная область окна проекта разбита на три части. Проект, представленный на рис. 4.1, пока не содержит ни одного трека. Но в будущем, после того как вы создадите хотя бы один трек (рис. 4.2), в средней части расположится список треков (Track list). В списке друг над другом будут располагаться поля треков и поля подтреков, содержащих автоматизацию. В этих полях будут доступны атрибуты и основные параметры треков. 
В нижней части списка треков расположена информационная строка, в которой отображается формат звуковых данных и максимальная суммарная длительность звуковых файлов проекта. Последний параметр вычисляется исходя из того, сколько свободного места имеется на том диске, на котором расположена папка проекта. 
Слева от списка треков находится поле, называемое инспектором (Inspector). В этом поле будут доступны для редактирования параметры выбранного трека. Поле инспектора можно скрыть или отобразить с помощью кнопки [image: image2.png]


, расположенной на панели инструментов. 
Справа от списка треков располагается область, в которой в графическом виде будет отображаться содержимое треков — это секция треков. Каждому полю в списке треков соответствует своя полоса в секции треков. На одном треке принято размещать партии, принадлежащие одному инструменту. 
Горизонталь в секции треков соответствует оси времени, которая берет начало от левой границы секции. В верхней части секции треков имеется шкала времени (Ruler). Она служит не только для отображения меток времени, но и предоставляет возможность управлять положением локаторов и указателем текущей позиции. 

4.1. Атрибуты MIDI-трека. Использование MIDI-эффектов и VSTi

Давайте создадим MIDI-трек. Для этого можно воспользоваться командой главного меню Project > Add Track > MIDI. Альтернативный способ — воспользоваться командой Add MIDI Track из контекстного меню списка треков. Результат показан на рис. 4.2. 

[image: image3.png]




Рис. 4.2. Окно Cubase SX Project (добавлен MIDI-трек)
4.1.1. Атрибуты MIDI-трека, доступные из списка треков

В списке треков появилось поле созданного трека (рис. 4.3, а). О том, что данный трек является именно MIDI-треком, свидетельствует символ [image: image4.png]


имеющийся в его поле. 
Размеры поля трека можно изменять, ухватившись курсором мыши за его правую или нижнюю границу. От размеров поля трека зависит расположение и количество видимых кнопок и полей (рис. 4.3, а, б, в). 
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Рис. 4.3 (а, б). Поле MIDI-трека
[image: image6.png]




Рис. 4.3, в. Поле MIDI-трека
Мы перечислим атрибуты MIDI-трека, показанные на рис. 4.3, б. Многие из них дублируются на панели инспектора. О них мы поговорим в следующем разделе. 
Название трека является его атрибутом. В нашем примере трек называется MIDI 01. Названия создаваемым трекам присваиваются автоматически. Если создать еще один MIDI-трек, то он будет называться MIDI 02, следующий MIDI 03 и т. д. Однако в любой момент название трека вы можете изменить. Для этого следует сделать двойной щелчок на поле с названием трека (поле станет доступным для редактирования) и ввести новое название. 
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— атрибут Mute. Когда он включен, данная кнопка подкрашена в желтый цвет и данный трек заглушен.
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— атрибут Solo. При его включении данная кнопка оказывается подкрашенной красным цветом, а все остальные треки переходят в состояние Mute.
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— атрибут готовности к записи Record Enable.
Сразу после создания нового трека атрибут Record Enable включен (кнопка [image: image10.png]


подкрашена красным цветом). Происходит это потому, что вновь созданный трек является выделенным, а в настройках Cubase SX по умолчанию установлен флажок Enable Record on Selected Track — включать атрибут готовности к записи у выделенных треков. Данная опция доступна в разделе Editing окна Preferences, вызываемого командой главного меню File > Preferences. Если запустить проект на запись, то информация, поступающая на входной MIDI-порт, с которым ассоциирован трек, будет сохраняться на данном треке. Вы можете включить атрибуты Record Enable одновременно для нескольких треков.
Здесь нам следует сделать небольшое отступление и рассмотреть один важный вопрос, касающийся режима Record Enable и режима мониторинга. Если включен атрибут Record Enable, то во время записи MIDI-данные, поступающие на входной MIDI-порт, ассоциированный с MIDI-треком, будут сохраняться на этом треке. Но будет ли при этом звучать тот инструмент, которому адресованы записываемые MIDI-команды? Не обязательно. При включении атрибута Record Enable незримо для пользователя включается режим мониторинга. В нем все данные, поступающие на вход MIDI-трека, транслируются на выходной MIDI-порт, с которым данный трек ассоциирован. При этом до начала записи и во время записи вы можете слышать собственную игру на MIDI-клавиатуре. Однако мониторинг будет осуществляться только в том случае, если включена опция MIDI Thru Active. Напомним путь к данной опции. Командой File > Preferences главного меню открывается диалоговое окно Preferences. Далее следует выбрать раздел MIDI, и опция станет доступной для включения/выключения.
Вы можете использовать мониторинг отдельно от режима Record Enable. Режим мониторинга включается кнопкой [image: image11.png]


, при этом кнопка [image: image12.png]


может быть выключена. Например, кнопка [image: image13.png]


окажется полезной в том случае, если в процессе записи требуется слышать звучание какого-либо трека, управляемого внешним MIDI-контроллером или секвенсором, но не требуется осуществлять запись MIDI-информации, поступающей именно на этот трек.
В правой части поля MIDI-трека имеется индикатор, который условно можно назвать индикатором уровня сигнала. Он загорается в момент поступления команды нажатия MIDI-клавиши. Высота светящегося столбика пропорциональна параметру Velocity (скорости нажатия MIDI-клавиши). При удержании MIDI-клавиши нажатой высота столбика плавно уменьшается. После того как MIDI-клавиша отпущена, высота столбика уменьшается очень быстро. Действительно, например, для инструмента Grand Piano громкость его звучания после нажатия MIDI-клавиши будет изменяться по описанному выше закону. Однако инструменты такого класса, как подкладки (pad'bi) будут звучать ровно до тех пор, пока MIDI-клавиша будет удерживаться нажатой. И громкость их звучания если и варьируется, то по более сложному закону. Что касается звучания ударных инструментов, то после фазы атаки их громкость обычно спадает независимо от того, удерживается нажатой MIDI-клавиша или нет. Именно поэтому мы сказали, что описываемый индикатор можно назвать индикатором уровня сигнала лишь условно. Ведь MIDI-трек не получает и не может получать аудиоинформацию с выхода управляемого им синтезатора или сэмплера. 
Перечислим остальные атрибуты MIDI-трека, показанные на рис. 4.3, б. 
Кнопки [image: image14.png]


(Read) и [image: image15.png]


(Write) разрешают воспроизведение и запись автоматизации.
Кнопка [image: image16.png]


(Edit VST Channel) вызывает появление линейки микшера, соответствующей данному MIDI-треку или панели соответствующего VSTi, если этот инструмент указан в качестве выходного порта трека.
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(Bypass Inserts) — временное отключение MIDI-эффектов, подключенных в режиме вставки (эффекты последовательного действия).
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(Disable Sends) — отключение посылов (шин, к которым подключаются MIDI-эффекты параллельного действия).
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(Drum Map) — вызывает меню, в котором можно выбрать барабанную карту, ассоциированную с данным MIDI-треком, или команду Drum Map Setup, вызывающую редактор барабанных карт. Барабанная карта — таблица соответствия ударных инструментов MIDI-нотам, MIDI-каналам и MIDI-инструментам. С помощью барабанных карт звуки различных инструментов, управляемых через различные MIDI-порты, можно объединять в наборы.
Кнопка [image: image20.png]


(Lock) блокирует или разблокирует трек. Изменение информации, хранящейся на заблокированном треке, невозможно. 
В левом нижнем углу поля трека имеется маленькая кнопка с символом + или —. С ее помощью открываются или скрываются поля подтреков, предназначенных для записи автоматизации. Об автоматизации мы поговорим отдельно (см. разд. 4.8), а сейчас перейдем к рассмотрению поля инспектора. 

4.1.2. Атрибуты и параметры MIDI-трека, доступные в поле инспектора; редактирование барабанной карты; применение MIDI-эффектов

Поле инспектора MIDI-трека (рис. 4.4.) состоит из пяти секций: 

·  основная секция, включающая в себя название трека и содержащая его основные параметры; 

·  секция Track Parameters, содержащая параметры некоторых алгоритмов преобразования MIDI-информации, работающих во время воспроизведения трека; 

·  секция Inserts, предназначенная для подключения MIDI-эффектов последовательного действия; 

·  секция Sends, предназначенная для подключения MIDI-эффектов параллельного действия; 

·  секция Channel, которая содержит одну единственную линейку микшера Cubase SX, соответствующую данному MIDI-треку. 

В правой верхней части каждой из секций имеется кнопка [image: image21.png]


или [image: image22.png]


с помощью которой данную секцию можно скрыть или, наоборот, сделать доступной. В скрытом виде отображаются только заголовки секций с их названиями и одной-двумя кнопками. Если в настройки какой-либо секции внесены изменения, отличные от принятых по умолчанию, то поле с кнопкой [image: image23.png]


или [image: image24.png]


соответствующей секции будет подсвечено синим или зеленым цветом. 
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Рис. 4.4. Инспектор MIDI-трека (основная секция)
Основная секция инспектора MIDI-трека

Рассмотрим элементы основной секции (рис. 4.4) в порядке убывания их значимости. 
В списке in: следует выбрать входной MIDI-порт, к которому подключен MIDI-контроллер (MIDI-клавиатура). Информация, поступающая через этот порт, будет сохраняться на треке в режиме записи. 
В списке out: следует выбрать выходной MIDI-порт или название MIDI-устройства, которому будет адресоваться информация, воспроизводимая с данного трека. Напомним, что настройка Cabase SX для работы с конкретными MIDI-устройствами осуществляется в окне MIDI Device Manager (см. разд. 2.1.). 
Если вы выберете в поле out: такое устройство, что в окне MIDI Device Manager не указан выходной MIDI-порт, к которому данное устройство подключено, то возникнет окно, показанное на рис. 4.5. Оно дублирует некоторые функции окна MIDI Device Manager. 
В списке chn: (см. рис. 4.4) выбирается MlDI-канал, по которому будет воспроизводиться информация данного трека. 
Если в качестве выходного MIDI-порта выбран синтезатор, скрипты для выбора патчей которого загружены в Cubase SX с помощью окна MIDI Device Manager, то в основной секции инспектора будет доступно поле [image: image26.png]


. Щелчком мыши на этом поле открывается браузер (обозреватель) патчей (рис. 4.6, а). С его помощью очень удобно перебирать патчи по их названиям, не задумываясь о том. какие они имеют номера и в каких банках находятся. Кроме того, вы можете сделать так, чтобы отображались не все доступные патчи, а только те из них, названия которых содержат последовательность символов, заданную в поле Filter. Например, если ввести в это поле "рпо", то в браузере отобразятся все патчи, содержащие данную подстроку. В нашем случае эта подстрока имеется в названиях всех патчей, имеющих отношение к звучанию фортепиано, пианино, электропианино и т. п. (рис. 4.6, б). 
Если в поле out: (см. рис. 4.4) выбран некий выходной MIDI-порт и Cubase SX "не знает", какое устройство к нему подключено (т. е. не загружены скрипты для выбора патчей), то вместо поля [image: image27.png]


в основной секции инспектора будут доступны поля [image: image28.png]


. В поле bnk: задается номер банка патчей, а в поле prg: — номер нужного патча в этом банке.
Щелчком мыши на поле [image: image29.png]map: Mo Drum Map



вызывается меню, аналогичное тому, что вызывается кнопкой [image: image30.png]


(Drum Map) из поля MIDI-трека. 
В данном меню можно выбрать барабанную карту, которая будет ассоциирована с данным MIDI-треком, или команду Drum Map Setup, вызывающую редактор барабанных карт. По умолчанию доступна только одна барабанная карта GM Map, которая соответствует распределению звуков ударных инструментов спецификации GM на MIDI-клавиатуре. Окно редактора барабанных карт показано на рис. 4.7. 
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Рис. 4.5. Окно My Device Setup
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Рис. 4.6.Браузер патчей
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Рис. 4.7. Окно диалога Drum Map Setup
В левой части редактора присутствует список барабанных карт Drum Maps. В правой части окна в виде таблицы располагается выбранная в списке Drum Maps карта (текущая карта). Создать новую карту можно нажатием на кнопку New Map. Новая барабанная карта будет иметь следующее название: Empty Map и, возможно, порядковый номер, если карт с таким же названием больше, чем одна. Чтобы изменить название карты, сделайте двойной щелчок мыши на старом названии карты в списке Drum Maps (поле с названием переключится в режим редактирования) и введите новое название. 
Кнопкой New Copy осуществляется создание копии выбранной в данный момент карты. С помощью кнопок Load и Save осуществляется загрузка и сохранение текущей карты в файлы с расширением DRM. 
Если нажать кнопку ОК, то окно редактора барабанных карт закроется и не более того. Если же нажать кнопку Assign, то данное окно тоже закроется, но при этом текущий MIDI-трек будет ассоциирован с той барабанной картой, которая была выбрана в списке Drum Maps. 
А теперь рассмотрим собственно барабанную карту. Как мы уже говорили, это, по сути дела, таблица, состоящая из следующих полей: 

·  Pitch — название ноты (не доступно для редактирования);  

·  Instrument — название ударного звука (доступно для редактирования);  

·  Quantize — длительность, к которой квантизируется сообщение;  

·  М — атрибут Mute (заглушить ударный звук); 

·  I-Note (Input Note, входящая нота) — при поступлении в Cubase SX данного MIDI-сообщения будет воспроизводиться ударный звук, соответствующий сообщению, указанному в поле графы O-Note; 

·  O-Note (Output Note, выходная нота) — сообщение, которое будет посылаться MIDI-инструменту при воспроизведении данного ударного звука; 

·  Channel — номер MIDI-канала;  

·  Output — выходной MIDI-порт. 

Если в качестве последнего параметра выбрать Default, то MIDI-сообщения будут адресоваться тому MIDI-порту, который выбран в списке Default, расположенном в левом нижнем углу окна Drum Maps Setup. 
Вернемся к рассмотрению основной секции инспектора MIDI-трека (см. рис. 4.4). 
Символами [image: image34.png]
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в основной секции инспектора обозначены регуляторы громкости, панорамы и время в миллисекундах, на которое при воспроизведении будут смещены все MIDI-команды, записанные на данном треке. Чтобы изменить положение регулятора, следует выполнить следующие действия: 

·  подвести к регулятору курсор мыши; 

·  нажать и удерживать нажатой левую кнопку мыши (возникнет более крупное изображение регулятора); 

·  перемещать курсор мыши в горизонтальном или вертикальном направлении в зависимости от того, как расположен регулятор (в данном случае регуляторы [image: image37.png]


, [image: image38.png]
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расположены горизонтально). 

На практике перемещать регуляторы гораздо проще, чем читать описание того, как это следует делать. Обычно около регулятора присутствует поле, которое не только отображает значение регулируемого параметра, но и позволяет его редактировать в цифровой форме.
Обратите внимание на то, что крайнее левое положение регуляторов громкости и панорамы не соответствует нулевым значениям параметров, как можно было бы предположить. В таком положении регуляторов сообщения об изменении громкости и панорамы не посылаются на выходной порт вовсе. Эта особенность позволяет избежать конфликтов в ситуации, когда несколько треков управляют одним и тем же синтезатором по одному и тому же MIDI-каналу. 
В основной панели инспектора присутствуют кнопки [image: image40.png]


(Mute), [image: image41.png]


(Solo), [image: image42.png]


(Enable Record) и [image: image43.png]


(Monitor), [image: image44.png]


(Lock), [image: image45.png]


(Read), [image: image46.png]


(Write). Назначение перечисленных кнопок мы уже рассмотрели. 
Кнопка [image: image47.png]


или [image: image48.png]


переключает способ представления времени для данного трека. При использовании музыкального времени (нажата кнопка [image: image49.png]


) все события, сохраненные на треке, привязываются к шкале, в основе которой лежат музыкальные единицы (такты, доли, тики). Однако промежуток времени в секундах от начала трека до определенного события будет зависеть от темпа. При использовании линейного времени (нажата кнопка [image: image50.png]


) промежуток от начала трека до определенного события не будет зависеть от темпа. Однако при изменении темпа будет происходить смещение событий относительно шкалы музыкального времени. 
Cubase SX позволяет преобразовывать входящие MIDI-данные "на лету", т. е. еще до того, когда они будут записаны на трек. Например, можно конвертировать один вид MIDI-сообщений в другой. 
Кнопка [image: image51.png]


открывает диалоговое окно Input Transformer (рис. 4.8, а), с помощью которого определяются параметры фильтрации и преобразования MIDI-данных, поступающих со входного MIDI-порта на трек. Фактически имеется четыре независимых модуля преобразования/обработки MIDI-данных. В группе Active Module следует отметить номера тех модулей, которые должны работать. В группе Selected Module выбирается номер того модуля, параметры которого будут доступны для редактирования. 
В списке Mode выбирается режим работы выбранного модуля: 

·  Filter — фильтрация MIDI-сообщений; 

·  Transform — преобразование MIDI-сообщений. 

В окне Input Transformer имеется два списка: в верхнем (столбцы Filter Target, Condition) определяются условия фильтрации, в нижнем (столбцы Action Target, Operation) определяются параметры преобразования MIDI-сообщения. Напротив каждого из списков имеется пара кнопок: Add Line (добавить строку в список) и Delete Line (удалить строку из списка). 
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Рис. 4.8.Диалоговое окно Input Transformer
Если выбран режим фильтрации, то будут использоваться параметры из верхнего списка. В режиме преобразования имеет значение содержимое обоих списков. 
Рассмотрим использование окна Input Transformer на примере. Для начала настроим его на фильтрацию сообщений определенного типа. Задействуем модуль 1 в режиме Filter. С помощью кнопки Add Line добавим строку в верхний список и будем редактировать ее содержимое. В поле Filter Target выберем способ фильтрации Type Is (по типу сообщения). В поле Condition выберем условие фильтрации Equal. В поле Parameter 1 выберем Note. В результате строка будет содержать следующее условие: Type Is Equal Note, что можно трактовать как "фильтровать (не пропускать) сообщения типа Note". Если теперь попробовать что-нибудь сыграть на MIDI-клавиатуре, подключенной к входному MIDl-порту, на работу с которым настроен трек, то ничего не произойдет — сообщения о нажатиях клавиш отсекаются фильтром. В то же время, сообщения любых типов, отличных от Note, будут проходить сквозь фильтр. Если же в поле Condition задать условие Unequal, то, наоборот, сквозь фильтр будут проходить только сообщения типа Note. Сообщения любых других типов сквозь фильтр не пройдут.
Вернем прежнее условие (Equal) и переключим модуль в режим Transform. Теперь условие фильтрации приобретет новый смысл: если в режиме фильтрации сообщения, удовлетворяющие определенным условиям, не пропускались, то теперь они будут пропускаться фильтром, но после этого они подвергнутся преобразованию в соответствии с параметрами, заданными в нижнем списке. То есть условия, заданные в верхнем списке, выделяют те сообщения из общего потока MIDI-данных, которые следует преобразовать. 
Нажатием кнопки Add Line добавим строку в нижний список. Попробуем транспонировать ноты на 12 (или сколько угодно) полутонов вверх. Для этого в поле Action Target выберем параметр Value 1 (первый параметр MIDI-сообщений, у сообщения Note — это номер MIDI-клавиши). В поле Operation (операция) выберем Add (добавить). В поле Parameter 1 нужно ввести число полутонов, которое следует добавить к номеру MIDI-клавиши (рис. 4.8, б). 
Аналогичным образом можно формировать гораздо более сложные условия фильтрации и преобразования MIDI-команд, ведь оба списка окна Input Transformer могут содержать сколько угодно строк с различными условиями. Кроме того, ведь всего существует четыре модуля, у каждого из которых имеется свой такой список. Однако мы больше не будем задерживаться на рассмотрении возможностей окна Input Transformer. В дальнейшем мы подробно рассмотрим работу с редактором Logical Editor (см. разд. 6.5.), который очень похож на окно Input Transformer. Разница заключается в том, что окно Input Transformer предназначено для редактирования параметров фильтрации и преобразования MIDI-данных в реальном времени, а с помощью окна Logical Editor осуществляется фильтрация и преобразование MIDI-данных, уже сохраненных на треке. Кроме того, в Cubase SX входит MIDI-плагин Transform, работающий в режиме реального времени. В данном плагине полностью реализованы возможности редактора Logical Editor. 
Фильтрация MIDI-сообщений может осуществляться в глобальных масштабах (для всего проекта в целом). Напомним, что командой File > Preferences вызывается диалоговое окно Preferences. В разделе MIDI > Filter доступны параметры фильтрации MIDI-сообщений, поступающих через входные порты. Их мы рассмотрели в разд. 2.2. Обратите внимание на то, что по умолчанию фильтруются (не пропускаются) сообщения типа SysEx. Иногда этот факт вызывает проблемы у начинающих пользователей Cubase SX. 
Если в качестве выходного порта MIDI-трека используется VSTi, то кнопка [image: image53.png]


откроет панель этого инструмента. О подключении VSTi к проекту п настройке MIDI-треков на работу с ними мы расскажем в разд. 4.1.3. Если MIDI-трек не используется для управления VSTi, то при нажатии на кнопку [image: image54.png]


откроется окно, показанное на рис. 4.9. В заголовке данного окна отображается название текущего трека. Несмотря на это, официально данное окно носит название VST Channel Settings. 
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Рис. 4.9. Окно VST Channel Settings (вариант окна для MIDI-трека)
В Cubase SX имеется виртуальный микшер, каждый модуль (strip) которого соответствует определенному треку. Окно, показанное на рис. 4.9, содержит в себе все элементы одного канала микшера, соответствующего MIDI-треку. Микшеру посвящена глава 5. 

Секция Track Parameters

Секция Track Parameters (рис. 4.10) содержит параметры некоторых алгоритмов преобразования MIDI-сообщений типа Note, работающих во время воспроизведения трека. 
В предыдущем разделе мы рассмотрели пример, в котором с помощью Input Transformer можно транспонировать ноты еще до того, как они были записаны на трек. В секции Track Parameters имеется параметр Transpose — количество полутонов, на которое ноты будут транспонироваться при воспроизведении трека. 
Vel. Shift — значение, которое будет складываться со значением параметра Velocity каждого сообщения типа Note (смещение параметра Velocity). 
Vel. Соmр. — степень компрессии параметра Velocity. О том, что представляет собой эффект компрессии применительно к MIDI-нотам, мы расскажем в разд. 9.4, посвященном MIDI-эффекту реального времени Compress. 
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Рис. 4.10. Инспектор (секция Track Parameters)
Len. Соmр. — изменение длительностей нот. Например, если задать значение этого параметра равным 3/4, то при воспроизведении длительности нот сократятся на 1/4, т. е. станут равными 3/4 от их первоначальной длительности. 
Random — внесение случайных изменений (рандомизация) в параметры сообщений типа Note, их координаты на временной оси и длительности. За счет рандомизации можно получить звучание, напоминающее игру живого исполнителя. В двух списках, расположенных непосредственно под надписью Random, выбираются параметры, подлежащие рандомизации. В терминологии Cubase SX эти параметры называются Target (цель работы алгоритма): 

·  Position — позиция на оси времени; 

·  Pitch — высота тона; 

·  Velocity — скорость нажатия на MIDI-клавишу; 

·  Length — длительность ноты; 

·  OFF — рандомизация отключена. 

В полях Min и Мах задаются границы случайных отклонений. 
Range — ограничение диапазона, в котором могут находиться параметры MIDI-сообщений, или фильтрация тех MIDI-сообщений, параметры которых не выходят за границы заданного диапазона. В двух списках, расположенных непосредственно под надписью Range, выбираются следующие целевые параметры: 

·  Vel.Limit — ограничение параметра Velocity; 

·  Vel.Filter — фильтрация нот по параметру Velocity (будут звучать только те ноты, у которых этот параметр не выходит за границы заданного диапазона); 

·  Note Limit — ограничение высоты нот; 

·  Note Filter — фильтрация нот по высоте (будут звучать только те ноты, высота которых не выходит за границы заданного диапазона); 

В полях Min и Мах задаются границы допустимых диапазонов. 
Вот пример, иллюстрирующий работу ограничения. Допустим, на треке сохранены три сообщения типа Note со значениями параметра Velocity, равными 40, 70, 127, и включено ограничение Velocity (Vel.Limit) с параметрами Min = 50, Max = 90. Теперь давайте посмотрим, что будет при воспроизведении. Поскольку Velocity первой ноты меньше нижней границы допустимых значений (40 < 50), то произойдет ограничение: реально будет воспроизведена нота с Velocity = 50. Параметр Velocity второй ноты попадает в диапазон допустимых значений (50 < 70 < 90), поэтому нота будет воспроизведена без изменения его значения. Параметр Velocity третьей ноты превышает верхнюю границу допустимых значений (127 > 90), поэтому сработает ограничение и реально будет воспроизведена нота с Velocity = 90. 
В начале раздела мы сказали, что алгоритмы преобразования MIDI-информации, управление которыми осуществляется из рассматриваемой секции инспектора, работают только применительно к MIDI-данным, воспроизводимым с трека. Однако в случае, если включен режим MIDI Thru (а по умолчанию он включен), то MIDI-данные, поступающие на входной порт MIDI-трека, будут ретранслироваться на его выходной порт. С большой натяжкой можно считать, что в этом случае MIDI-данные, поступающие на входной порт MIDI-трека, как бы воспроизводятся. Некоторые алгоритмы обработки MIDI-сообщений, параметры которых доступны в секции Track Parameters, будут работать применительно к ретранслируемым в режиме MIDI Thru MIDI-сообщениям. Это касается алгоритмов, затрагивающих параметры Velocity и Pitch. Данные параметры передаются вместе с сообщениями о нажатии MIDI-клавиш, поэтому программа может обрабатывать их в реальном времени. Другое дело — алгоритмы, затрагивающие длительность нот и их расположение во времени. Они в принципе не могут работать в режиме реального времени, поскольку программе не известно, когда вы нажмете клавишу на MIDI-клавиатуре и сколько времени продержите ее нажатой. 
Обращаем ваше внимание на кнопку[image: image57.png]


, расположенную на заголовке секции Track Parameters. С ее помощью осуществляется временное отключение всех алгоритмов обработки MIDI-сообщений, управляемых из данной секции. 

Секция Inserts, подключение MIDI-эффектов

Секция Inserts (рис. 4.11) служит для подключения MIDI-эффектов последовательного действия. Эффекты последовательного действия подключаются , к треку по цепочке: при воспроизведении данных с трека происходит их обработка сначала одним эффектом, потом другим и т. д. Иными словами, на вход очередного эффекта поступают данные, уже обработанные предыдущим эффектом. После обработки последним эффектом данные поступают на выходной порт трека. 
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Рис. 4.11. Инспектор (секция Inserts)
В секции имеются четыре ячейки для подключения эффектов. В каждой из них есть список для выбора нужного эффекта. По умолчанию во всех списках выбран элемент No Effect (эффект не подключен). В Cubase SX доступны следующие MIDI-эффекты: 

·  Arpache 5 — арпеджиатор; 

·  AutoPan — автоматическое панорамирование; 

·  Chorder — генератор аккордов; 

·  Compress — компрессор параметра Velocity; 

·  Control — генерация сообщений типа Control Change; 

·  Density — прореживание или генерация дополнительных нот; 

·  Micro Tuner — индивидуальная подстройка каждой ноты в октаве; 

·  MidiEcho — генерация эха; 

·  Note 2 СС — конвертор MIDI-сообщения типа Note в сообщения типа Control Change; 

·  Quantizer — квантизатор; 

·  Step Designer — паттерновый секвенсор; 

·  Track Control — контрольная панель для управления основными параметрами синтезаторов стандартов GS и XG; 

·  Track FX — набор эффектов, идентичных тем, что доступны из секции Track Parameters плюс еще два эффекта — смещение во времени (аналогичный параметр доступен в основной секции) и Scale Transpose (транспозиция в соответствии с тональностью композиции); 

·  Transformer — эффект реального времени, возможности которого аналогичны возможностям редактора Logical Editor (см. разд. 6.5). 

Подробно MIDI-эффекты будут рассмотрены в главе 9. А сейчас вернемся к рассмотрению секции Inserts инспектора. 
Итак, подключение эффектов осуществляется довольно просто: щелкаете на надписи No Effect или на названии уже подключенного эффекта (чтобы заменить этот эффект) и выбираете нужный эффект из меню (рис. 4.12, а). 
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Рис. 4.12. Инспектор (секция Inserts, подключение эффектов)
В зависимости от того, какие из эффектов подключены, их параметры могут быть доступны или не доступны из секции Inserts. На рис. 4.12, б показано, что подключено четыре эффекта: Arpache 5, AutoPan, Control и Compress. 
Однако для редактирования доступны параметры лишь двух эффектов: Control и Compress. С помощью кнопок [image: image60.png]


можно вызывать окна тех эффектов, параметры которых не доступны в секции Inserts. С помощью этой же кнопки можно скрыть и вновь сделать доступными параметры тех эффектов, которые отображаются непосредственно в секции Inserts. 
С помощью кнопки [image: image61.png]


эффекты можно временно отключать. Кнопка расположенная в заголовке секции Inserts, временно отключает все эффекты, подключенные в секции. 
На всякий случай поясним, какая разница между выражениями "отключить эффект" и "временно отключить эффект". Отключить эффект — значит задать No Effect для той ячейки секции, к которой он был подключен. При этом все выполненные вами изменения параметров эффекта пропадут. Временно отключить эффект — значит воспользоваться кнопкой [image: image62.png]


и исключить эффект из цепи обработки (bypass). В любой момент с помощью этой же кнопки вы сможете вернуть эффект в цепь обработки, при этом все ранее выполненные настройки данного эффекта сохраняются. 

Секция Sends

Основным назначением секции Sends (посылы) является обеспечение подключения MlDI-эффектов параллельного действия (рис. 4.13). 
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Рис. 4.13. Инспектор (секция Sends)
Эффекты параллельного действия подключаются к треку независимо друг от друга. На вход каждого из эффектов посылаются данные непосредственно с трека. После обработки данные поступают на указанный выходной порт, который может отличаться от выходного порта трека. 
В Cubase SX к каждому из MIDI-треков вы можете подключить до четырех эффектов параллельного действия. Каждому из эффектов соответствует своя ячейка секции Sends, состоящая из нескольких раскрывающихся списков и кнопок. По умолчанию эффекты не подключены ни к одной из ячеек, чему соответствует надпись No Effect. Подключение эффектов осуществляется точно так же, как и в секции Inserts: выбором названия эффекта из списка. После подключения эффекта следует задать выходной порт, которому будут адресоваться обработанные данные. По умолчанию вместо названий выходных портов фигурируют надписи Not Connected (нет соединения). Кроме порта можно задать номер MIDI-канала, по которому будут передаваться данные. По умолчанию для всех эффектов выбран канал 1. В списке для выбора номера MIDI-канала кроме номеров от 1 до 16 присутствует еще и элемент ANY (любой). Выбор этого элемента означает, что после обработки эффектом MIDI-данные будут передаваться по тому же каналу, что задан для данного MIDI-трека. В каждой из ячеек секции Sends имеются следующие кнопки: [image: image64.png]


— включение/выключение посыла; 
[image: image65.png]


— отображение/скрытие параметров эффекта в секции Sends или вызов окна эффекта;
[image: image66.png]


— переключение Pre/Post.
Обратите внимание на то, что кнопка [image: image67.png]


служит для включения/выключения именно посыла, а не эффекта. Дело в том, что, как мы уже говорили, обеспечение подключения MIDI-эффектов параллельного действия является основным назначением секции Sends. Но это назначение не является единственным. Вы можете использовать посылы и без подключения каких-либо эффектов. Ведь с помощью посылов вы можете направлять копию потока MIDI-данных, поступающих с трека, на любой MIDI-канал любого выходного порта. Эту особенность можно использовать для создания сложных тембров, когда одни и те же ноты передаются разным синтезаторам. Само собой разумеется, что направлять информацию можно не только на порты, которые физически присутствуют в системе, но и на порты виртуальных синтезаторов VSTi, задействованных в конкретном проекте. 

Секция Channel

Мы повторимся, сказав, что секция Channel (рис. 4.14) содержит одну единственную линейку микшера Cubase SX, которая соответствует данному MIDI-треку. 
Больше нам сейчас добавить нечего, поскольку детальный анализ микшера Cubase SX еще впереди, рассматривать же одну из его линеек (с урезанными возможностями) смысла нет. 

4.1.3. Подключение VSTi

Командой главного меню Devices > VST Instruments вызовите окно, показанное на рис. 4.15. 
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Рис. 4.14. Инспектор (секция Channel)
[image: image69.png]| ©vstinstruments

Ix






Рис. 4.15. Окно VST Instruments
В данном окне имеется 32 слота для подключения VSTi, которые соответственно пронумерованы цифрами от 1 до 32. По умолчанию VSTi не подключены ни к одному из слотов, и в каждом слоте имеется надпись No VST Instrument (нет VSTi). Заметим, что для данного окна доступна опция Always on Top, вызываемая щелчком правой кнопкой мыши на нем. Если опция включена, то в ходе работы с Cubase SX окно не будет перекрываться другими окнами и всегда будет оставаться на поверхности. Удобно, когда список подключенных инструментов всегда перед глазами. 
Чтобы подключить VSTi к нужному слоту, щелкните на соответствующей надписи No VST Instrument левой кнопкой мыши. Возникнет меню, содержащее названия доступных VSTi. Возможный вид этого меню показан на рис. 4.16, а. После выбора VSTi он окажется подключенным к тому слоту, на котором вы щелкали мышью, вызывая меню (рис. 4.16, б). 
Непустой слот отличается от пустых: вместо надписи No VST Instrument появилось название подключенного VSTi (в нашем случае a1). Под названием VSTi отображается название текущего патча, загруженного в инструмент. 
Его название можно редактировать. С помощью кнопки [image: image70.png]


вызывается список патчей из текущего банка. Альтернативный способ выбора патчей — их последовательный перебор с помощью кнопок [image: image71.png]
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Рис. 4.16. Подключение VSTi
Кнопкой [image: image73.png]


открывается окно VSTi. VSTi — это плагины, т. е. уникальные программы. Соответственно у разных VSTi окна выглядят по-разному: на них вынесены различные органы управления, присущие для конкретного VST, они имеют различный дизайн. Детальному описанию VSTi посвящена глава 10. Допустим, что кнопкой [image: image74.png]


вы открыли окно VSTi, отрегулировали различные параметры синтеза, добившись нужного звучания. В результате получился уникальный, созданный лично вами патч. Теперь, чтобы его сохранить, нужно воспользоваться кнопкой File. Эта кнопка присутствует и в окне VST Instruments, и в окне любого из VSTi. Кнопка File вызывает меню, состоящее из следующих пунктов: 

·  Load Bank — загрузить банк патчей из файла; 

·  Save Bank — сохранить банк патчей в файл; 

·  Load Instrument — загрузить один патч из файла и сделать его текущим; 

·  Save Instrument — сохранить текущий патч в файле. 

Стоит упомянуть о кнопке [image: image75.png]


служащей для временного отключения VSTi. 
В дальнейшем, если возникнет ситуация, когда необходимый VSTi не звучит, хотя и подключен по всем правилам, проверьте состояние этой кнопки. 
Итак, после подключения VSTi к одному из слотов окна VST Instruments можно считать данный инструмент подключенным к проекту. Остается настроить какой-либо MIDI-трек на работу с этим VSTi. 
Сделать это очень просто: в параметрах необходимого трека в качестве выходного MIDI-порта укажите название требуемого VSTi (рис. 4.17, а). Этот виртуальный MIDI-порт появился в вашем проекте сразу после подключения VSTi в слот окна VST Instruments. 

[image: image76.png]




Рис. 4.17. Выбор VSTi в качестве выходного порта MIDI-трека (а), выбор нужного патча с помощью браузера (б)
Если в качестве входного порта MIDI-трека установлен порт, к которому подключена MIDI-клавиатура, то вы сможете играть на ней звуками VSTi. Напомним, что это возможно в том случае, когда включен режим MIDI Thru и для конкретного MIDI-трека включен мониторинг (оба режима по умолчанию включены). 
Вы можете подключать несколько экземпляров одного и того же VSTi. Это имеет смысл делать в том случае, если VSTi являются однотембральными, а вам нужно звучание нескольких патчей одного и того же VSTi. Названия виртуальных MIDI-портов разных экземпляров одного и того же VSTi будут иметь следующий формат: название VSTi, порядковый номер (кроме 1). 
Кстати, выбирать патчи VSTi удобнее всего с помощью браузера патчей, расположенного в основной секции инспектора (рис. 4.17, б). 
VSTi реализованы посредством VST-плагинов, управляемых по протоколу MIDI. На выходе любого VST-плагина — поток аудиоданных. В конечном счете, этот поток поступает на один из выходных аудиопортов Cubase SX (VST Outputs). Но было бы заманчиво обрабатывать выходной сигнал VSTi любыми аудиоэффектами, доступными из Cubase SX. Это возможно. При подключении VSTi к проекту для данного инструмента на виртуальном микшере Cubase SX (см. главу 5) создается отдельный модуль. По своим функциональным возможностям он практически не отличается от тех модулей микшера, которые соответствуют аудиотрекам. Читая разд. 4.7.8, вам предстоит разобраться в том, как работает автоматизация параметров синтеза VSTi. Забегая вперед, скажем, что для автоматизации VSTi используется специальный трек, на котором (на разных подтреках) могут храниться данные автоматизации всех VSTi, используемых в проекте.

4.2. Атрибуты аудиотрека

Создадим аудиотрек (рис. 4.18). Для этого можно воспользоваться командой главного меню Project > Add Track > Audio. Альтернативный способ — воспользоваться командой Add Audio Track из контекстного меню списка треков. 
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Рис. 4.18. Окно Cubase SX Project (добавлен аудиотрек}
4.2.1. Атрибуты аудиотрека, доступные из списка треков

В списке треков появилось поле созданного трека (см. рис. 4.18). О том, что данный трек является именно аудиотреком, свидетельствует символ [image: image78.png]


имеющийся в его поле. 

[image: image79.png]




Рис. 4.19. Поле аудиотрека в списке треков
Только два атрибута в поле аудиотрека являются присущими именно аудио-, а не MIDI-треку: 
[image: image80.png]


— временное отключение эквалайзера;
[image: image81.png]


— переключатель моно/стерео.
Кнопкой [image: image82.png]


включается внутренний мониторинг — трансляция потока звуковых данных сквозь Cubase SX. Аналогичная кнопка имеется и среди атрибутов MIDI-трека. Мониторинг звука является достаточно серьезной проблемой, рассмотренной в разд. 2.7. 
Все остальные атрибуты аналогичны тем, что имеются у MIDI-треков. Естественно, следует учитывать, что если речь идет о подключении к аудиотрекам эффектов реального времени, то подразумевается подключение VST-или DX-плагинов, а не MIDI-плагинов. 
В правой части поля атрибута аудиотрека имеется индикатор уровня сигнала. В отличие от аналогичного индикатора MIDI-трека он показывает реальный уровень сигнала. С помощью контекстного меню окна Mixer вы можете изменить режим работы всех индикаторов уровня аудиосигналов, присутствующих в проекте (см. разд. 5.2). 

4.2.2. Атрибуты и параметры аудиотрека, доступные в поле инспектора; применение аудиоэффектов реального времени

Поле инспектора аудиотрека (рис. 4.20) состоит из пяти секций: 

·  основная секция содержит основные параметры трека; 

·  секция Inserts служит для подключения аудиоэффектов последовательного действия; 

·  секция Equalizers содержит элементы управления параметрическими эквалайзерами; 

·  секция Sends служит для подключения аудиоэффектов параллельного действия; 

·  секция Channel содержит одну единственную линейку микшера Cubase SX, которая соответствует данному треку. 

Параметрические эквалайзеры, в принципе, тоже являются аудиоэффектами реального времени. Однако следует учитывать то, что данные эффекты являются неотъемлемой частью аудиотрека. Они как бы встроены в него. Когда же мы говорим о подключении аудиоэффектов параллельного или последовательного действия, то подразумеваем под этим подключение к аудиотреку VST- или DX-плагинов.

Основная секция инспектора аудиотрека; немного о пространственном панорамировании 

Как видно из рис. 4.20, внешне основная секция инспектора аудиотрека мало отличается от аналогичной секции инспектора MIDI-трека. Однако принципиальные отличия все же имеются. 
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Рис. 4.20. Инспектор аудиотрека (основная секция)
Кнопка [image: image84.png]


— переключает режимы моно/стерео. 
Командой главного меню Project > Auto Fades Settings вызывается диалоговое окно Auto Fades, с помощью которого задаются параметры автоматического фейда и кроссфейда. Эти параметры распространяются на все аудио-треки проекта. Однако имеется возможность определять эти параметры индивидуально для каждого из аудиотреков. С помощью кнопки [image: image85.png]


вызывается диалоговое окно Auto Fades — Track:<название трека>. Оно аналогично окну Auto Fades, однако параметры, доступные в нем, распространяются только на текущий трек. 
Кнопка [image: image86.png]


открывает диалоговое окно VST Channel Settings, показанное на рис. 4.21. Хотя в заголовке данного окна отображается только название трека, официальное название окна именно VST Channel Settings. 
С окном VST Channel Settings мы уже встречались, когда рассматривали атрибуты MIDI-трека. Теперь мы столкнулись с вариантом этого же окна, предназначенным для управления аудиотреком. Можете провести эксперимент: оставить данное окно открытым и выбрать в качестве текущего MIDI-трек. Содержание окна VST Channel Settings изменится соответствующим 
образом. Обратите внимание: когда вы щелкнете мышью на окне проекта, чтобы выбрать трек, то окно проекта получит фокус и может закрыть собою окно VST Channel Settings. Поднять VST Channel Settings на "поверхность экрана" (над остальными окнами) можно, выбрав название текущего трека из меню Window. 
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Рис. 4.21. Диалоговое окно VST Channel Settings (вариант для аудиотрека)
Однако вернемся к рассмотрению окна VST Channel Settings, вызванного для аудиотрека (см. рис. 4.21). В нем собраны практически все параметры аудиотрека. Большинство элементов данного окна дублируется в других секциях инспектора и окна Mixer, которое мы рассмотрим в главе 5. Если приглядеться, то окно VST Channel Settings можно разделить на четыре области (слева направо): 

·  секция фейдера громкости, панорамы и других параметров; 

·  секция эффектов параллельного действия; 

·  секция эквалайзера; 

·  секция эффектов последовательного действия. 

Особое внимание стоит обратить на секцию эквалайзера, а именно на верхнюю ее часть, в которой отображается амплитудно-частотная характеристика (АЧХ). Здесь АЧХ эквалайзера аудиотрека можно редактировать в графической форме: с помощью курсора мыши вы размещаете узлы АЧХ, расположение которых определяет настройку параметрических фильтров. 
С помощью кнопки [image: image88.png]


осуществляется сохранение настроек эквалайзера в пресете, а с помощью кнопки [image: image89.png]


текущий пресет удаляется. Выбрать нужный пресет можно в списке, расположенном левее этих кнопок. По умолчанию пресетам присваиваются названия Preset 1, Preset 2 и т. д. Вы можете переименовать нужный пресет, как вам угодно. Для этого сначала сделайте двойной щелчок на списке пресетов. А затем в возникшем диалоговом окне Type In Preset Name введите название пресета и нажмите ОК.
После каких-либо манипуляций с окном VST Channel Settings могут оказаться полезными кнопки [image: image90.png]


, которые приводят соответствующие секции в исходное состояние. 
Вернемся к рассмотрению основной секции инспектора аудиотрека (см. рис. 4.20). 
Напомним, что мы рассматриваем те элементы управления, которые отсутствуют в инспекторе MIDI-трека или отличаются от его аналогичных элементов. 
В нижней части основной секции имеются два поля: in и out. Здесь можно выбрать входной и выходной порты аудиотрека. Напомним, что с помощью окон VST Inputs и VST Outputs, вызываемых командами главного меню Devices > VST Inputs и Devices > VST Outputs соответственно (см. разд. 2.6), вы можете посмотреть, какие каналы или шины ввода/вывода цифрового звука вам в принципе доступны (это зависит от аппаратных возможностей звуковой карты и ее драйверов). В этих же окнах вы можете включать, выключать, а также переименовывать каналы и шины в случае необходимости. 
Итак, в качестве выходного порта аудиотрека можно выбрать канал (например. Left — левый стереоканал), шину (например, BUS 1 — стереопару, включающую в себя каналы Left и Right) или SurroundPan — пространственное панорамирование. 
Сделаем небольшое отступление. Для размещения источников звука на стереопанораме фактически используется всего одна координата — удаление источника от центра панорамы (координата лево- право). В зависимости от значения этой координаты будет изменяться громкость сигнала в стереоканалах. Например, при панорамировании источника звука влево громкость сигнала этого источника в левом канале останется без изменений или возрастет в зависимости от выбранного метода панорамирования (параметр Stereo Pan Law окна Project Setup — см. разд. 2.9), а его же громкость в правом канале будет уменьшаться до полного исчезновения сигнала. Если расположить источник звука в центре стереопанорамы, причем сам источник является монофоническим (не имеет кажущейся протяженности по стереопанораме), то его сигнал в левом и правом стереоканалах будет одинаковым. Если же в центре стереопанорамы разместить стереофонический источник звука, то громкость его собственных стереоканалов изменяться не будет. Так устроено стереофоническое панорамирование. Программа изменяет в стереоканалах громкость сигнала, воспроизводимого с трека, в соответствии с описанным выше принципом. 
В случае пространственного панорамирования для расположения звуковых источников вокруг слушателя используется уже две координаты: лево- право и впереди- позади. В принципе, не важно, сколько каналов в вашей акустической системе: их может быть по-прежнему всего два, но если в качестве выходного порта аудиотрека выбран SurroundPan, то для позиционирования звуковых источников в пространстве будет использоваться уже две координаты. Напомним, что с помощью команды Devices > VST Master Setup открывается окно диалога VST Master Setup. В этом окне вы указываете Cubase SX, какая именно акустическая система у вас используется (см. разд. 2.6). В зависимости от этого будут применяться конкретные алгоритмы пространственного панорамирования. 
В принципе, пространственное панорамирование по своей сути ничем не отличается от панорамирования в стерео. Как и в случае стерео, в зависимости от заданных вами координат источника звука программа будет изменять громкость его сигнала в разных каналах таким образом, чтобы получить его соответствующую пространственную локализацию. Вся разница в количестве каналов. Допустим, у вас квадрофоническая система (четыре канала — левый/правый фронтальные и левый/правый тыловые) и вы размещаете в пространстве монофонический источник. Если его поместить перед собой, то будут звучать левый и правый фронтальные каналы. При перемещении источника слева от себя будут звучать левые фронтальный и тыловой каналы. При размещении источника где-то далеко сзади и слева будет звучать только левый тыловой канат. Еще пример: система 5.1. Фронтальные каналы: левый, центральный, правый; тыловые каналы: левый, правый. При размещении источника перед собой будет звучать центральный канал. При размещении источника справа от себя будут звучать правые фронтальный и тыловой каналы и т. д. Правда, в системе 5.1. имеется еще один канал (в названии системы он обозначается единичкой) — канал сабвуфера. Человек не в состоянии определять направление на источник низкочастотного звука, поэтому где физически будет размещаться сабвуфер — справа, слева, спереди или сзади — не имеет значения. В дальнейшем вы увидите, что в Cubase SX в полной мере поддерживаются возможности многоканальных аудиосистем вплоть до 5.1. И, естественно, у вас будет возможность управлять уровнем сигнала в канале сабвуфера. 
А сейчас, совсем не надолго, вернемся к основной секции инспектора аудиотрека (см. рис. 4.20). Допустим, в качестве выходного порта аудиотрека выбран SurroundPan. При этом вид регулятора панорамы в основной секции инспектора останется неизменным и не появится никакого нового регулятора, позволяющего перемещать источник вдоль второй координатной линии (вперед-назад). Поддержка пространственного панорамирования в полной мере реализована в секции Channel инспектора аудиотрека и в микшере (окно Mixer). Кроме того, пространственное панорамирование поддерживается автоматизацией. Это, например, означает, что вы можете заставить как угодно перемещаться вокруг слушателя звук, воспроизводимый с аудиотрека. 

Секция Inserts

Секция Inserts (рис. 4.22) служит для подключения аудиоэффектов последовательного действия. Эффекты последовательного действия подключаются к треку по цепочке: при воспроизведении данных с трека происходит их обработка сначала одним эффектом, потом другим и т. д. Иными словами, на вход очередного эффекта поступают данные, уже обработанные предыдущим эффектом. После обработки последним эффектом данные поступают на выходной порт трека. 
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Рис. 4.22. Секция Inserts инспектора аудиотрека

К аудиотреку можно подключить до восьми эффектов последовательного действия. Слоты для подключения эффектов обозначены цифрами от 1 до 8. По умолчанию ни к одному из них не подключено ни одного эффекта: в каждом из слотов в поле названия эффекта присутствует надпись No Effect (нет эффекта). Чтобы подключить эффект к нужному слоту, щелкните на соответствующей надписи No Effect левой кнопкой мыши, возникнет система меню, включающая в себя все доступные VST- и DX-плагины. В ней и следует выбрать нужный эффект. Надпись No Effect заменится названием подключенного эффекта. Если хотите в этот же слот подключить другой эффект — щелкните по названию ненужного эффекта, появляется меню — выбираете нужный эффект. Если эффект требуется просто отключить — вместо нового эффекта следует выбрать No Effect.
Кнопками [image: image92.png]


имеющимися у каждого из восьми слотов, осуществляется временное отключение эффектов (bypass). Кнопка [image: image93.png]


расположенная на заголовке поля Inserts, предназначена для временного отключения всех эффектов последовательного действия, подключенных к треку.
Кнопки [image: image94.png]


, расположенные около каждого из слотов, служат для вызова панелей эффектов, подключенных к соответствующим слотам. Аналогичная кнопка имеется и на заголовке поля Inserts. Она вызывает диалоговое окно Channel Strip (рис. 4.21). 
Вообще кнопки [image: image95.png]


и [image: image96.png]


имеются в заголовках последующих секций инспектора аудиотреков. Мы больше не будем упоминать о них, т. к. их назначение для разных секций остается неизменным.

Секция Equalizers

Секция Equalizers (рис. 4.23) содержит поля четырех фильтров, условно названных hi, hi mid, lo mid и lo. В каждой из секций имеется по три регулятора, расположенных горизонтально. Верхним регулятором задается степень усиления или ослабления сигнала на частоте, заданной средним регулятором. Нижним регулятором задается добротность фильтра.
У каждого из фильтров имеется по кнопке [image: image97.png]


для их временного отключения. 

[image: image98.png]nserts

Equalzers =

Channel =





Рис. 4.23. Секция Equalizers инспектора аудиотрека
Секция Sends

Маршрутизация потоков цифрового звука в Cubase SX осуществляется подобно маршрутизации сигналов в классическом аппаратном микшере. Как вы уже знаете, к аудиоканалам можно подключить эффекты в режиме вставки (Insertion). Второй способ применения эффектов в микшере заключается в их подключении к шинам Aux: сигнал с каждого из каналов можно послать на любую из этих шин. После обработки внешними процессорами эффектов сигнал возвращается в общий микс. Регулятором уровня посылаемого на шину сигнала определяется глубина эффекта. Аналогичный способ применения эффектов параллельного действия реализован и в Cubase SX.
В секции Sends (посылы) расположены восемь регуляторов (рис. 4.24, а), обозначенных цифрами от 1 до 8. Каждый из них управляет уровнем сигнала, посылаемого с аудиотрека на одну из восьми шин. В принципе, эти шины можно было бы назвать шинами Aux, но в Cubase SX они не называются никак. 
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Рис. 4.24. Секция Sends инспектора аудиотрека
Регуляторы уровня посылаемого сигнала распложены горизонтально и на рис. 4.24, а находятся под надписями No Effect. 
Кнопка [image: image100.png]


служит для включения/выключения посыла. Кнопкой [image: image101.png]


открывается панель эффекта, на который осуществляется посыл. Кнопкой [image: image102.png]


осуществляется переключение режима посыла: Post или Рrе. Напомним, что режим Рrе — это когда сигнал "отводится" на посыл до того, как он пройдет регулировку уровня громкости, a Post — после регулировки уровня громкости.
С помощью кнопки [image: image103.png]


, расположенной на заголовке секции Sends или команды Devices > VST Send Effects, открывается диалоговое окно VST Send Effects, показанное на рис, 4.25, а. В данном окне имеется восемь слотов-шин для подключения аудиоэффектов. Подключим к первому слоту какой-либо VST- или DX-плагин (рис. 4.25, б). Мы уже неоднократно описывали процедуру подключения эффектов (например, при рассмотрении секции Inserts). 
Основное, на что следует обратить здесь внимание, — список, расположенный в правом нижнем углу слота. На нашем рисунке в нем по умолчанию выбран элемент Master. В данном списке выбирается одна из доступных основных шин. На нее будет возвращаться сигнал, обработанный эффектом. 
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Рис. 4.25.Диалоговое окно VST Send Effects
Итак, сигнал с любого из аудиотреков можно послать на любой из восьми эффектов, подключаемых в окне VST Send Effects. Обработанные сигналы будут возвращены на заданные основные шины. Скорее всего, по умолчанию для вас доступна всего одна основная шина, называемая Master. На эту же шину по умолчанию сводятся сигналы со всех треков. Напомним, что с помощью команды Devices > VST Outputs открывается окно VST Outputs, в котором можно посмотреть, какие основные шины, в принципе, имеются в вашем распоряжении (их состав и особенности зависят от возможностей звуковой карты и ее драйверов). В этом же окне можно включать/выключать основные шины, а также переименовывать их. 
Вкратце рассмотрим элементы окна VST Send Effects, доступные при условии, что подключен хотя бы один эффект (рис. 4.25, 6). 
Кнопка [image: image105.png]


служит для временного отключения эффекта. Кнопкой [image: image106.png]


открывается панель эффекта. У вас есть возможность перебирать пресеты с настройками эффекта, не открывая его панели. Для этого служат кнопки [image: image107.png]


и [image: image108.png]


Справа от этих кнопок расположено поле-список, в котором отображается название текущего пресета. В нем же можно выбрать пресет по названию. Над кнопками [image: image109.png]


и [image: image110.png]


расположен регулятор уровня сигнала, подаваемого на вход эффекта. 
Кнопка File открывает меню, содержащее команды сохранения в файл и считывания из файла отдельных пресетов или целых банков пресетов. Итак, к первому слоту окна VST Send Effects мы подключили эффект. Теперь вернемся к рассмотрению секции Sends инспектора аудиотрека (рис. 4.24, б). Как видите, первый регулятор посыла теперь имеет название эффекта. Обращайте внимание не состояние кнопки [image: image111.png]


(включение/выключение посыла). Подключение эффекта в окне VST Send Effects не означает автоматического включения посыла. Это логично, ведь аудиоэффекты параллельного действия являются общими для всех треков. Подключение эффекта не должно привести к его наложению на все треки, эффекты следует вводить в проект плавно, добавлять "по вкусу". 
В завершении раздела хотим обратить ваше внимание на одну особенность применения аудиоэффектов. Практически в каждом из эффектов присутствует параметр, определяющий отношение уровней обработанного и исходного сигнала на выходе эффекта. Обычно этот параметр называется Dry/Wet. Однако в тех VST-плагинах, которые входят в поставку с Cubase, этот параметр называется Mix, хотя возможны и комбинации (например, регулятор называется Mix, а с ним рядом располагаются два поля Dry и Wet). Если эффект подключен к треку в режиме вставки (Inserts), то значение данного параметра подбирается в зависимости от конкретного эффекта. Например, для реверберации значение Dry должно быть больше Wet. Для компрессии на выходе эффекта должен присутствовать только обработанный сигнал (Dry = 0%, Wet = 100% или Mix = 100%). Конечно, жестких правил по применению приведенных в качестве примера эффектов не существует, но любые другие значения Dry/Wet будут просто бессмысленными. Если же аудиоэффект подключен в качестве эффекта параллельного действия (Sends), то в его параметрах следует задавать Dry = 0 %, Wet = 100 % или Mix = 100 %. Тогда соответствующими регуляторами посыла вы сможете регулировать глубину эффекта независимо для каждого из треков. В противном случае необработанный сигнал с выхода эффекта (ведь "противный случай" — это когда Dry > 0 %) будет смешиваться с таким же сигналом с выхода трека. В большинстве ситуаций (когда сигналы с трека и с выхода эффекта поступают на одну и ту же шину) это бессмысленно. Отсюда правило — эффекты, для которых значение Dry должно быть больше 0 или равно 100 % (например, компрессор), применять в качестве эффектов параллельного действия не следует.

Секция Channel

Секция Channel (рис. 4.26, а) содержит одну единственную линейку микшера Cubase SX, которая соответствует данному аудиотреку. Особо стоит отметить, что по сравнению с возможностями микшера (окна Mixer), возможности этой секции инспектора аудиотрека являются сильно урезанными. Тем не менее, если в качестве выходного порта аудиотрека задан виртуальный порт SurroundPan, в секции Channel можно осуществлять пространственное панорамирование. Вместо регулятора стереопанорамы будет доступно поле в форме кружка с точкой [image: image112.png]


Кружок символизирует окружающее пространство, точка — расположение источника звука в этом пространстве (рис. 4.26, б). Точку можно перемещать, но это не самый удобный способ панорамирования. Если сделать двойной щелчок на данном поле, откроется окно Рanner, с помощью которого можно тонко управлять пространственным панорамированием. Подробное описание данного окна мы приведем в разд. 5.4. 
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Рис. 4.26. Секция Channel инспектора аудиотрека
4.3. Назначение и атрибуты групповых треков

Групповые треки являются вспомогательными. Как и следует из их названия, они предназначены для группировки сигналов от нескольких аудиотреков в целях обработки полученного субмикса одним набором эффектов. 
Давайте создадим групповой трек. Для этого можно воспользоваться командой главного меню Project > Add Track > Group Channel. Альтернативный способ — воспользоваться командой Add Group Channel Track из контекстного меню списка треков. Еще нам понадобится минимум два аудиотрека. Их мы и будем группировать. На рис. 4.27 проиллюстрировано следующее: созданы три аудиотрека (Audio 01 — Audio 03) и один групповой трек (Group 01), показано поле группового трека в списке треков и основная секция инспектора группового трека. 
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Рис. 4.27. Создан групповой трек
В качестве выходных портов группируемых аудиотреков следует выбрать название созданного группового трека (в нашем примере — Group 01). После микширования сигналы сгруппированных треков будут проходить обработку эффектами, подключенными к групповому треку. Применение эффектов к групповому треку ничем не отличается от применения эффектов к аудио-трекам. У инспектора группового трека, как и у инспектора аудиотрека, тоже имеются аналогичные секции Inserts, Equalizers и Sends. 
Основная секция инспектора группового трека представляет собой "урезанный вариант" аналогичной секции аудиотрека. Может возникнуть вопрос: куда девается сигнал с выхода группового трека, ведь в основной секции его инспектора нет поля для выбора выходного порта? Здесь-то нам в первый раз и пригодится секция Channel (рис. 4.28, а). Она содержит одну-единственную линейку микшера Cubase SX, которая соответствует данному групповому треку, а только с помощью микшера можно задать выходной аудиопорт для группового трека. 
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Рис. 4.28. Выбор выходного аудиопорта для группового трека
В самой нижней части линейки отображается название выходного порта группового трека. Если на нем щелкнуть (рис. 4.28, а), то возникнет меню, показанное на рис. 4.28, б. В этом меню и осуществляется выбор выходного аудиопорта. В нашем примере этот выбор невелик. Однако в качестве выходного порта можно было бы выбрать другой групповой трек, если бы он присутствовал в проекте. В принципе, так (по цепочке) можно было бы соединить между собой сколько угодно треков. Для чего это нужно — решать вам. Мы лишь приведем пример использования механизма группировки треков.
Допустим, у вас имеется шесть аудиотреков. Три из них нужно обработать компрессором с одними параметрами, а три других трека — также компрессором, но уже с другими параметрами. Кроме того, нужно иметь возможность корректировки тембра эквалайзером всех этих треков одновременно. Таковы условия вымышленного примера. Если бы не существовало групповых треков, то эта задача решалась бы следующим образом. 
К каждому из треков в режиме вставки следовало бы подключить по эффекту компрессии (всего 6 экземпляров плагина компрессора!). Вторая часть задачи — одновременная корректировка тембра всех треков — не решалась бы в принципе. Пришлось бы по очереди выполнять настройки эквалайзера для каждого из треков (фактически было бы задействовано 6 эквалайзеров!). Теперь расскажем о том, как эффектно решается поставленная задача с помощью групповых треков. 
Первые три трека объединяются в группу, к ней подключается один эффект компрессии. Вторые три трека объединяются во вторую группу, к ней тоже подключается эффект компрессии, но уже с другими параметрами. Обе группы объединяются в третью группу, и осуществляется регулировка тембра всей группы с помощью эквалайзера третьего группового трека. Итого задействовано два эффекта компрессии и один эквалайзер. Задача решена, ресурсы процессора сэкономлены. 

4.4. Секция треков

Секция треков располагается справа от списка треков (рис. 4.29). Каждому полю в списке треков соответствует своя горизонтальная полоса в секции треков. Эта полоса, собственно, и есть трек. Полосы отгорожены друг от друга тонкими "выпуклыми" границами, которые не так-то просто разглядеть на рисунке, но реально они существуют. 
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Рис. 4.29. Окно Cubase SX Project (большую часть занимает секция треков)
4.4.1. Части (parts), первое знакомство

В нашем примере в проекте имеется два трека: MIDI- и аудиотрек. На них, соответственно, могут храниться MIDI- и аудиосообщения. Однако любые сообщения могут храниться лишь внутри так называемых частей (parts), которые, в свою очередь, хранятся на треках. Причем MIDI-сообщения могут храниться только в MIDI-частях, которые могут располагаться только на MIDI-треках. Аудиосообщения могут храниться непосредственно на аудиотреках. 
Части создаются автоматически во время записи MIDI- или аудиоинформации. Однако существует и другой путь создания частей. Нажмите кнопку [image: image117.png]


расположенную на панели инструментов окна проекта. Данный инструмент называется Draw (рисовать). Нарисуем с его помощью прямоугольник, расположенный на MIDI-треке. Для этого подведем курсор к тому месту трека, где будет находиться одна из сторон прямоугольника (рис. 4.30, а), нажмем левую кнопку мыши и потащим курсор мыши по горизонтали (4.30, б). Около курсора будет отображаться текущая координата курсора на оси времени и длина (Length) рисуемого прямоугольника. Когда мы отпустим кнопку мыши, возникнет некий прямоугольный объект (на рис. 4.30, в он называется MIDI 01). Этот объект есть не что иное, как часть. В данном случае она не содержит внутри себя ни одного MIDI-сообщения. 
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Рис. 4.30.Создание части с помощью инструмента Draw
Нажмите кнопку [image: image119.png]


расположенную на панели инструментов окна проекта. Инструмент называется Object Selection (выбор объекта). После этого сделайте двойной щелчок над только что нарисованной частью. Если вы не изменили соответствующую опцию диалогового окна Preferences, вызываемого командой главного меню File > Preferences, то после двойного щелчка откроется окно Key Editor (рис. 4.31, а) — редактор отпечатков клавиш. 
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Рис. 4.31. Рисование отпечатков клавиш
С его помощью вы можете нарисовать (рис. 4.31, а, б) и отредактировать отпечатки MIDI-клавиш. Чтобы нарисовать отпечаток клавиши, воспользуйтесь инструментом [image: image121.png]


(Draw), расположенным на панели инструментов окна Key Editor. Каждый из этих отпечатков соответствует сообщению типа Note. Когда вы будете их рисовать, будет звучать тот инструмент, на работу с которым настроен данный MIDI-трек. 
Все отпечатки клавиш, которые вы нарисуете, будут относиться только к той части, щелчком на которой был вызван редактор Key Editor. Закроем окно редактора отпечатков клавиш (подробно мы поговорим о нем в разд. 6.3), и посмотрим, что получилось с нашей частью (рис. 4.32, а). 
Теперь часть не пуста, в ней появились горизонтальные черточки — они соответствуют сообщениям типа Note. 
В принципе, сообщения могут находиться за пределами части. Дело в том, что вы можете передвигать вертикальные границы части. Для этого в нижних углах части имеются маленькие белые квадраты. Ухватившись за любой из этих квадратов, вы можете передвигать границу в любом направлении, например в направлении другой границы (рис. 4.32, б). 
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Рис. 4.32. В часть добавлено два сообщения типа Note
Вы можете так "задвинуть" границу части, что она вообще не будет иметь протяженности на оси времени (рис. 4.32, в). Тем не менее, все сообщения, находящиеся внутри части, останутся на своих местах. В этом легко убедиться, если вернуть границу части на ее прежнее место (рис. 4.32, г). Прямоугольник части следует воспринимать как некое окно: если сообщения видны в этом окне, они будут воспроизводиться при воспроизведении всего проекта. Если они скрыты за пределами окна, то и воспроизводиться не будут. Тем не менее, если данные сообщения в принципе существуют, то они будут существовать вне зависимости от того, видим мы их или нет.
На панели инструментов окна проекта (справа) имеется поле Color Selector (выглядит как цветовая палитра). Щелчком на данном поле открывается меню, в котором можно задать цвет для выбранной части (или группы частей). В этом же меню имеется команда Select Colors. Она открывает диалоговое окно Event Colors Setup, с помощью которого можно очень тонко настраивать оттенки цветов в палитре. Есть ли в этом необходимость — решать вам. 

4.4.2. Шкала времени Ruler, указатель текущей позиции, расширенные функции управления воспроизведением проекта и изменение масштаба отображения графических объектов секции треков

В верхней части секции треков расположена черная шкала времени (Ruler) с номерами тактов. Если вы не изменили опцию Display Format в диалоговом окне Project Setup, вызываемого командой главного меню Project > Project Setup, то. по умолчанию шкала времени будет отградуирована в формате такт: доля (Basr+Beats). Цифры от 1 до 4 на рис. 4.33 — это номера тактов. Если вы хотите быстро изменить формат шкалы времени, щелкните на кнопке [image: image123.png]


расположенной справа от шкалы. Возникнет раскрывающийся список, в котором вы сможете выбрать новый формат времени. 
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Рис. 4.33. Шкала времени и указатель текущей позиции проекта
В действительности шкала времени разделена невидимой горизонтальной границей на две половины. Если один раз щелкнуть на нижней половине, то в точку, соответствующую положению курсора, переместится указатель текущей позиции проекта — вертикальная линия. Начиная от указателя текущей позиции, будет осуществляться воспроизведение проекта, если вы подадите соответствующую команду. Когда вы перемещаете указатель текущей позиции в необходимое место проекта и запускаете воспроизведение, программа проделывает невидимую работу — приводит MIDI-устройства в состояние, актуальное для данной позиции проекта. Если где-то перед текущей позицией проекта находятся сообщения о смене MIDI-инструмента, об изменении значений каких-либо контроллеров и т. п., то соответствующие MIDI-сообщения передаются на выходные порты MIDI-треков в момент, предшествующий началу воспроизведения. 
В разделе Chase Events Filter окна Preferences, вызываемого командой главного меню Edit > Preferences, вы можете исключить отдельные виды сообщений из перечня актуализируемых. Например, по умолчанию установлен флажок Sysex. Это значит, что актуальные для новой позиции проекта сообщения типа Sysex не будут пересылаться при запуске воспроизведения. 
Во время воспроизведения линия указателя текущей позиции будет плавно перемещаться слева направо, указывая на то место проекта, которое воспроизводится в данный момент. 
Если на панели инструментов окна проекта нажата кнопка [image: image125.png]


(Autoscroll), то во время воспроизведения проекта будет осуществляться автоматический скроллинг секции треков и текущая позиция проекта всегда будет находиться в зоне видимости. В противном случае указатель текущей позиции может уйти за пределы видимой области проекта. 
Воспроизведение проекта может быть инициировано нажатием кнопки [image: image126.png]


(Start) на панели инструментов окна проекта или на транспортной панели. Чтобы остановить воспроизведение проекта, можно воспользоваться кнопкой [image: image127.png]


(Stop). Однако это не единственный способ запуска/остановки воспроизведения. Конечно, можно пользоваться горячими клавишами, но в Cubase SX существуют расширенные функции для управления воспроизведением проекта. Например, двойной щелчок на нижней половине шкалы времени вызывает воспроизведение проекта, начиная с позиции курсора. 
На панели инструментов окна проекта имеется кнопка [image: image128.png]


(Scrub) или [image: image129.png]


(Play), точнее, на одном и том же месте может располагаться одна из названных кнопок. Например, если в данный момент доступна кнопка [image: image130.png]


(Scrub), а вам потребуется кнопка [image: image131.png]


(Play), то следует выполнить следующие действия:

·  нажать кнопку [image: image132.png]


(Scrub) (она окрасится в бирюзовый цвет); 

·  повторным щелчком на кнопке [image: image133.png]


(Scrub) вызвать меню;  

·  в меню выбрать другую функцию для кнопки — Play. 

При смене функции изменится и изображение кнопки, поэтому можно говорить о двух кнопках, которые могут располагаться на одном и том же месте. С подобными кнопками вы еще не раз столкнетесь. От всех остальных они отличаются наличием маленького треугольника в правом нижнем углу. 
А теперь вернемся к выяснению того, для чего, собственно, нужны инструменты [image: image134.png]


(Scrub) и [image: image135.png]


(Play). Инструменту [image: image136.png]


(Scrub) в секции треков соответствует курсор мыши [image: image137.png]


. Если сделать один щелчок левой кнопкой мыши, то указатель текущей позиции переместится в позицию курсора. Если перемещать курсор мыши, удерживая нажатой ее левую кнопку, то начнется воспроизведение проекта. Однако воспроизведение будет несколько специфичным: указатель текущей позиции будет стремиться поспеть за курсором мыши. Причем чем дальше указатель от курсора, тем с большей скоростью будет осуществляться воспроизведение. А по мере приближения указателя к курсору скорость воспроизведения будет замедляться. Однако если слишком резко дернуть курсор, то указатель текущей позиции не станет за ним гоняться, а просто "прыгнет" к нему. При таких делах и речи быть не может о том, чтобы воспроизведение осуществлялось в соответствии с заданным темпом. Воспроизведение вообще может осуществляться в обратную сторону! Для чего же нужен режим Scrub? Представьте, что перед вами проигрыватель виниловых дисков. Рукой вы можете замедлить вращение диска, остановить его или заставить вращаться в обратном направлении. Такими приемами часто пользуются DJ. Режим Scrub позволяет использовать эти приемы в Cubase SX, но несколько в других целях: вы можете тщательно, неоднократно прослушать нужный фрагмент проекта, не отвлекаясь при этом на лишние нажатия кнопок.
Режим [image: image138.png]


(Play) тоже служит этой цели, но является более консервативным: если разместить курсор мыши (в данном режиме он примет вид [image: image139.png]


над секцией треков, нажать и удерживать нажатой левую кнопку мыши, то начнется воспроизведение проекта с нормальной скоростью, начиная с позиции курсора. Как только вы отпустите кнопку мыши, воспроизведение прекратится. 
Вернемся к рассмотрению шкалы времени. Если подвести курсор мыши к верхней половине шкалы времени, то он примет форму карандаша. С помощью карандаша вы можете обозначить отрезок проекта, ограниченный левым и правым локаторами (рис. 4.34, а). Графически локаторы отображаются в виде треугольников, соединенных линией. О том, что такое локаторы и для чего они нужны, мы рассказали в разд. 3.2. На всякий случай 
напомним, что локаторы — это многофункциональные указатели, ограничивающие на оси времени некую область проекта, с которой предполагается выполнять какие-либо действия. Например, если сделать двойной щелчок на области какого-либо трека, расположенной между локаторами, то в этом месте будет создана часть. 
Ухватившись курсором за один из локаторов, вы можете перемещать его в горизонтальном направлении. Обратите внимание на то, что отрезок проекта, ограниченный локаторами, можно нечаянно "вывернуть на изнанку". Это произойдет в том случае, если правый локатор окажется левее левого локатора, а левый локатор, соответственно, окажется правее правого (рис. 4.34, б). В этом случае некоторые функции просто не будут работать. Например, вы не сможете включить режим циклического воспроизведения/записи. Напомним, что данный режим включается кнопкой [image: image140.png]


, расположенной на транспортной панели или на панели инструментов окна проекта. 
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Рис. 4.34. Выделение отрезка проекта локаторами
В области окна проекта, занимаемой секцией треков, присутствуют полосы прокрутки, с помощью которых вы можете выбирать фрагмент проекта, отображаемый в секции и доступный для редактирования. Полосы прокрутки — не самый удобный способ "перемотки" проекта. Тем не менее, такой способ существует, и вы можете его использовать. Если у вашей мыши имеется колесо для скроллинга, то в данном случае вы его можете задействовать: щелкаете один раз на полосе прокрутки (чтобы она получила фокус), после чего вращаете колесо — происходит скроллинг. 
В правом нижнем углу окна проекта имеются поля [image: image142.png]


. С их помощью вы можете изменять масштаб отображения графических объектов  секции треков по горизонтали и по вертикали. Слева от такого поля назначенного для изменения масштаба по горизонтали, расположена кнопка [image: image143.png]


. Нажатием на нее вызывается меню команд, связанных с изменением масштаба по горизонтали. Перечислим их: 

·  Zoom Full — изменить масштаб так, чтобы в секции треков умещались все части проекта; 

·  Zoom to Locators — изменить масштаб так, чтобы область проекта, ограниченная локаторами, занимала всю секцию треков; 

·  Add — сохранить текущий масштаб в виде пресета; 

·  Organize — вызвать окно органайзера пресетов горизонтального масштаба. 

Вызов команды Add приведет к появлению стандартного для Cubase SX окна диалога Type In Preset Name для ввода названия сохраняемого пресета. После сохранения нового пресета соответствующий пункт добавится в меню, команды которого мы только что перечислили. 
Команда Organizer вызывает окно, показанное на рис. 4.35. Окно содержит список имеющихся пресетов масштаба по горизонтали Zoom Presets. С помощью кнопки Rename вы можете переименовать выбранный пресет, а с помощью кнопки Delete — удалить его. 
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Рис. 4.35.Органайзер пресетов масштаба по горизонтали
Над полем, предназначенным для изменения масштаба по вертикали, также имеется кнопка >[image: image145.png]


. Нажатием на нее вызывается меню команд, связанных с изменением масштаба по вертикали: 

·  Zoom Tracks 1 Rows — установить такой масштаб и высоту треков, чтобы в соответствующих им полях списка треков умещалось по одному ряду атрибутов; 

·  Zoom Tracks 2 Rows и Zoom Tracks 3 Rows — команды аналогичны предыдущей с поправкой, что ширина полей треков будет соответствовать 2 и 3 рядам атрибутов; 

·  Zoom Tracks 4 Rows — команда подобна предыдущим, только количество рядов атрибутов треков задается вами в окне диалога Type in number of rows; 

·  Zoom Tracks Full — установить такую высоту треков, чтобы они все умещались в окне проекта (по вертикали); 

·  Zoom 4 Tracks и Zoom 8 Tracks — установить такую высоту треков, чтобы в окне проекта по вертикали умещалось 4 и 8 треков соответственно; 

·  Zoom N Tracks — команда подобна предыдущим, только количество видимых в окне проекта треков вы задаете сами в диалоговом окне Type in number of tracks; 

·  Zoom Tracks Minimal — установить минимальную высоту треков; 

·  Если включена опция Snap Track Heights, то изменять высоту отдельных треков вы сможете с дискретностью, соответствующей одному ряду атрибутов. 

В правой верхней области секции треков имеется расположенный вертикально регулятор. С его помощью можно изменять масштаб отображения сообщений в частях. Например, на рис. 4.36, а, б показан вид MIDI-часги при разных положениях регулятора. Каждая горизонтальная черта в ней соответствует MIDI-сообщению. 
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Рис. 4.36. Изменение масштаба отображения сообщений в частях
В Cubase SX предусмотрено мощное средство для управления масштабом отображения проекта по вертикали и быстрого доступа к любой точке проекта. 
На панели инструментов окна проекта имеется кнопка [image: image147.png]


(Show Overview). Если ее нажать, под панелью инструментов окна проекта появится дополнительная область Overview (обзор), возможный вид которой показан на рис. 4.37. Маленькими закрашенными прямоугольниками на ней отображаются части. Большая прямоугольная рамка (the track view rectangle) соответствует области проекта, отображаемой в секции треков. Ухватившись мышью за вертикальный край рамки, вы можете изменять размер прямоугольника по горизонтали. Размер видимой области проекта изменится. При этом, естественно, изменится масштаб отображения объектов секции треков таким образом, чтобы видимая область вписалась в размер секции треков. 
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Рис. 4.37. Поле обзора проекта
Вы можете ухватиться за прямоугольную рамку обзора и перетащить в горизонтальном направлении (хвататься нужно за нижнюю половинку области, ограниченной рамкой). При этом в секции треков будет осуществляться скроллинг, соответствующий перемещению рамки. 
Еще одна возможность: вы можете нарисовать рамку на новом месте. Подводите курсор мыши в нужное место на поле обзора проекта, нажмите левую кнопку мыши, удерживайте ее и перемещайте курсор по горизонтали. Когда вы отпустите кнопку мыши, рамка обзора окажется на новом месте: ее вертикальные границы будут соответствовать позициям курсора в моменты нажатия и отпускания кнопки мыши. 
В Cubase SX имеется еще одно средство управления масштабом секции треков! На панели инструментов окна проекта имеется кнопка [image: image149.png]


(Zoom). 
Если с помощью данного инструмента выделить область секции треков, то вертикальный и горизонтальный масштабы изменятся таким образом, чтобы выделенная область занимала всю секцию треков. На всякий случай поясним, что "выделить область" фактически означает построить с помощью курсора мыши прямоугольник так, как это делается в графических редакторах. Кстати, вы можете использовать инструмент [image: image150.png]


(Zoom) и по-другому: щелкать им на области треков. При этом масштаб будет увеличиваться (изображение будет становиться более детальным). Если использовать инструмент [image: image151.png]


(Zoom) в сочетании с одной из клавиш: <Ctrl>, <Shift> или <АН>, то результат будет следующим: 

·  (Zoom) + <Alt> — уменьшение масштаба по горизонтали; 

·  (Zoom) + <Shift> — весь проект будет сделан видимым; 

·  (Zoom) + <Ctrl> — уменьшение масштаба по горизонтали и по вертикали. 

4.4.3. Запись MIDI и звука

Проведем несколько практических занятий по осуществлению записи MIDI- и аудиоинформации. Заметим, что в Cubase SX существует возможность импортирования MIDI- и аудиофайлов, файлов в форматах предыдущих версий Cubase. To есть запись MIDI и звука — не единственный возможный источник материала для вашего проекта. 

Подготовка MIDI- и аудиотреков к записи

Подготовим какой-нибудь один MIDI- или аудиотрек к записи. Подготовка MIDI-трека сводится к выполнению следующих действий: 

·  создать MIDI-трек (если в этом есть необходимость); 

·  если трек уже существует, нужно щелкнуть на соответствующем поле в списке треков. При этом данный трек окажется выделенным, его атрибут Record Enable (готовность к записи) окажется включенным (при условии, что в настройках — File > Preferences > Editing — установлен флажок Enable Record on Selected Track), инспектор будет отображать атрибуты данного трека; 

·  если атрибут Record Enable выключен (такое возможно при сброшенном флажке Enable Record on Selected Track), то его следует включить; 

·  в поле in: основной секции инспектора следует выбрать входной MIDI-порт, к которому подключена MIDI-клавиатура; 

·  в поле out: следует выбрать MIDI-порт, к которому подключен синтезатор или сэмплер, звуками которого вы собираетесь играть на MID1-клавиатуре; 

·  если требуется, следует выбрать выходной MIDI-канал, банк, патч, соответствующий нужному тембру, или выбрать непосредственно сам тембр по его названию. 

Если вы собираетесь играть звуками виртуального инструмента VST, то соответствующий инструмент должен быть предварительно подключен к вашему проекту (см. разд. 4.1.3). 
Подготовка аудиотрека к записи по своей идеологии ничем не отличается от подготовки MIDI-трека. Вся разница заключается в том, что для данного трека вы должны указать в качестве входного аудиопорта тот порт, который соответствует микрофону или какому-либо другому источнику аудиосигнала. Однако у записи звука имеется своя особенность: вы должны правильно подобрать уровень записываемого сигнала. При включенном атрибуте Record Enable индикатор уровня сигнала аудиотрека будет показывать уровень сигнала, поступающего через заданный входной аудиопорт. Вы должны попросить вокалиста или исполнителя спеть или сыграть ту партию, которую предполагается записать. В ходе этой репетиции регулятором микшера звуковой карты вы должны подобрать уровень записываемого сигнала таким, чтобы не происходило клиппирования (индикатор не должен попадать в красную зону) и в то же время сигнал должен быть достаточно сильным. При этом удобнее всего пользоваться индикатором уровня сигнала, расположенным в секции Channel поля инспектора.
Вы будете вынуждены обратить внимание на то, что регулятор уровня сигнала, являющийся атрибутом трека, никак не воздействует на уровень сигнала, поступающего на трек. Он управляет уровнем сигнала, воспроизводимого с трека и не более того. 
Подбирать уровень записываемого сигнала нужно с помощью микшера звуковой карты. Однако в некоторых случаях, обусловленных особенностями драйверов звуковой карты, сделать это затруднительно. Например, при использовании ASIO-драйверов некоторых звуковых карт сигнал с их кодека поступает в Cubase SX, минуя микшер. Единственный способ подбора уровня сигнала в данном случае — воспользоваться регулировками микрофонного предусилителя или микшера, через который к компьютеру подключен микрофон либо другой источник аудиосигнала. Приведем пример еще одной возможной проблемы на примере работы со звуковой картой SB Audigy. Допустим, микрофон подключен непосредственно к микрофонному входу звуковой карты. Записать сигнал, поступающий с микрофона, можно через ASIO-порты, которые на панели VST Inputs (см. разд. 2.6) называются MIX (Pre-EQ) L/R или MIX (Post-EQ) L/R. С помощью микшера данной звуковой карты вы сможете регулировать уровень микрофонного сигнала в общем миксе. Однако во время записи в этот микс попадет звучание остальных треков вашего проекта, а ведь вам нужно записать только сигнал от микрофона! 
Чтобы избежать каких-либо проблем с записью вокала или акустических инструментов, мы рекомендуем использовать в домашней звуковой студии для этой цели следующее оборудование: 

·  полупрофессиональную звуковую карту класса M-Audio Audiophile 2496, единственным назначением которой является высококачественная запись и воспроизведение цифрового звука (подобные звуковые карты стоят не дороже мультимедийных звуковых карт из верхней ценовой категории); 

·  высококачественный микрофонный предусилитель (возможно, в составе микшера); 

·  высококачественный микрофон (желательно конденсаторный). 

Конечно, такой комплект стоит дороже мультимедийной звуковой карты и мультимедийного микрофона, однако без него вы просто не сможете реализовать возможности Cubase SX. Если же вы предполагаете использовать Cubase SX только для записи инструментальных композиций без привлечения живых инструментов, тогда, естественно, перечисленное выше оборудование может и не понадобиться. Тем не менее, вы должны иметь качественную звуковую карту хотя бы для того, чтобы слушать результаты вашей деятельности.
Еще она деталь, на которую следует обратить внимание при записи звука, — имеет смысл задать такой режим для аудиотрека (моно или стерео), который бы соответствовал реальным свойствам записываемого сигнала. Например, если вы записываете звук с монофонического микрофона, то трек, соответственно, имеет смысл сделать монофоническим. Если вы записываете звучание стереофонического синтезатора, трек должен быть стереофоническим. 
Напомним, что до записи и во время нее вы можете использовать внутренний мониторинг (см. разд. 2.7). 

Способы переключения программы в режим записи

Будем считать, что MIDI- или аудиотрек готов к записи. Переключить программу в режим записи можно несколькими способами. Приведем некоторые из них. 

Способ 1. На шкале времени The ruler следует подвести левый локатор к той позиции, начиная с которой необходимо произвести запись. Нажать кнопку [image: image152.png]


(Record) на транспортной панели или на панели инструментов окна проекта. 
Способ 2. Отвести указатель текущей позиции проекта левее того места, начиная с которого необходимо осуществить запись. Кнопкой [image: image153.png]


(Start) на транспортной панели или на панели инструментов окна проекта запустить воспроизведение проекта. Когда указатель текущей позиции дойдет до нужного места, нажать кнопку [image: image154.png]


для переключения в режим записи.
Способ 3. На шкале времени The ruler следует подвести левый локатор к той позиции, начиная с которой необходимо произвести запись. Отвести указатель текущей позиции проекта левее левого локатора. На транспортной панели нажать кнопку [image: image155.png]


(punch in). Кнопкой [image: image156.png]


(Start) на транспортной панели или на панели инструментов окна проекта запустить воспроизведение проекта. Когда указатель текущей позиции подойдет к позиции левого локатора, произойдет автоматическое переключение в режим записи. Если же вместо кнопки [image: image157.png]


нажать кнопку [image: image158.png]


то запись начнется сразу с той позиции, что соответствует левому локатору. 
Способ 4. Данный способ является развитием способа 3. Если нажать на транспортной панели кнопку [image: image159.png]


(punch out), то при достижении указателем текущей позиции правого локатора произойдет автоматический выход из режима записи. То есть получается, что с помощью левого и правого локаторов вы ограничиваете отрезок проекта, в пределах которого будет автоматически выполняться запись. Повторимся, что вы должны проследить за тем, чтобы левый локатор не оказался правее правого и наоборот. В противном случае выполнить запись не удастся.

Режим записи бок о бок соседствует с режимом воспроизведения. То есть невозможно запустить программу в режиме записи, чтобы при этом не работал режим воспроизведения. Если в вашем проекте уже существуют другие треки с записанными на них партиями инструментов, то в режиме записи вы будете слышать их звучание. 
В режиме записи вам (или исполнителю, с которым вы работаете) следует исполнить то, ради чего организован сеанс записи (спеть вокальную партию в микрофон или сыграть мелодию на MIDI-клавиатуре). Чтобы остановить запись, воспользуйтесь кнопкой [image: image160.png]


(Stop) на транспортной панели или панели инструментов окна проекта. 
В результате записи MIDI, должна появиться часть, содержащая записанные сообщения. В результате записи звука, на аудиотреке должно появиться звуковое сообщение, возможный вид которого показан на рис. 4.38. 
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Рис. 4.38. Аудиосообщение содержит вокальную партию
Знаете, как убедиться в том, что данный графический объект является именно аудиосообщением, а не частью? Если выбрать аудиосообщение, щелкнув на нем, в его верхней части появятся три маленьких фигуры (два треугольника и квадрат), называемых узлами. Перемещая их, можно сформировать огибающую громкости для данного аудиосообщения. У частей огибающих не бывает. 
Если вы собираетесь выполнить запись на MIDI-трек, который уже содержит какую-то информацию, то стоит обратить внимание на существование описанных ниже режимов записи. 

Режимы записи, циклическая запись, регионы аудиосообщений

На транспортной панели имеется область, показанная на рис. 4.39. В ее верхней части (поле Rec Mode) щелчком на надписи Normal или Merge переключается способ записи новой части, если она нахлестывается на ту часть, что уже существует:

·  Normal — новая часть будет замешать собою существующую; 

·  Merge — новые сообщения будут дописываться в существующую часть. 
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Рис. 4.39. Режимы записи, доступные с транспортной панели
В последнем случае в старой части сохранятся и те сообщения, что там уже присутствовали, и записанные вновь. 
Что касается аудиосообщений и аудиочастей, то на них описанные режимы записи не распространяются. При записи новых аудиосообщений поверх существующих аудиосообщений или частей происходит их наслоение. Аудиосообщения оказываются как бы одно над другим. Новые сообщения находятся на поверхности экрана, а старые оказываются "под ними". При воспроизведении выводится та аудиоинформация, которая находится именно на поверхности. С помощью команды То Front контекстного меню, вызываемого щелчком правой кнопки мыши над "слоеными" аудиосообщениями или частями, вы можете выбрать любые из них для отображения на поверхности экрана. В дальнейшем вы можете растащить наслоившиеся аудиосообщения на разные треки или в разные позиции одного трека. Одним словом, никаких потерь информации при записи одного аудиосообщения поверх другого не происходит. 
На транспортной панели имеется кнопка [image: image163.png]


(Loop), включающая режим циклического воспроизведения/записи. Циклическую запись можно применять в комбинации со всеми способами записи, описанными в предыдущем разделе. 
С точки зрения пользователя, циклическая запись происходит следующим образом: 

·  запись происходит только на отрезке проекта, ограниченном левым и правым локаторами; 

·  при достижении указателем текущей позиции правого локатора, указатель перескакивает в позицию левого локатора (в начало цикла), и так происходит до тех пор, пока вы не нажмете кнопку [image: image164.png]


(Stop). 

Существуют два режима циклической записи MIDI-сообщений. В нижней части области транспортной панели, показанной на рис. 4.39, имеется поле Cycle Rec. Щелчком на надписи Mix или Overwrite переключаются режимы циклической записи:

·  Mix — при каждом циклическом проходе от левого локатора к правому новые сообщения будут добавляться в часть без удаления уже существующих сообщений; 

·  Overwrite — при каждом очередном проходе ранее записанные сообщения будут удаляться. 

Первый режим может быть полезен, например, в том случае, если вы хотите записать партию ударных инструментов за несколько проходов: при первом проходе прописываете партию большого барабана, при втором — партию малого барабана и т. д. 
Второй режим может быть полезен в том случае, если вы хотите записать импровизацию: запускаете циклическую запись и импровизируете. Если чувствуете, что последний вариант вам понравился, — останавливаете запись. 
Описанные режимы циклической записи опять-таки не распространяются на запись звука. 
Для аудиосообщений существуют другие режимы циклической записи. Однако прежде чем перейти к их рассмотрению, следует немного углубиться в изучение сущности аудиосообщений Cubase SX. 
Как мы уже говорили, аудиосообщение представляет собой объект, содержащий ссылку на звуковой файл и набор неких атрибутов. Среди этих атрибутов, например, имеются координаты узлов, формирующих огибающую громкости, атрибуты Event Start и Event End — координаты начала и окончания воспроизводимой области звукового файла, отсчитываемые от его начала, и др. Однако в данный момент нас больше интересует то, что аудиосообщения могут быть как бы многослойными — содержать несколько регионов. Один аудиофайл может быть разбит на несколько регионов. Физически, конечно, звуковой файл остается неделимым, и отсчеты звуковых волн хранятся последовательно — в том же порядке, в каком они были записаны. Но среди атрибутов аудиосообшений могут присутствовать метки начат и окончаний регионов (координаты границ регионов, задаваемые от начала сэмпла). Причем не существует никаких жестких ограничений на расположение этих меток. Поэтому регионы могут иметь произвольную длину (не выходящую за пределы сэмпла) и располагаться внахлест. Однако метка начала региона не может располагаться после метки ее окончания, Cubase SX просто не допускает этого. В окне проекта может отображаться и воспроизводиться только один регион аудиосообщения. Если вызвать контекстное меню, щелкнув правой кнопкой мыши на аудиосообщений, то в нем будет доступна команда Set To Region, с помощью которой можно выбрать тот регион сообщения, который будет использоваться в проекте. Если уж нам быть совсем точными, то в действительности при выборе региона из окна проекта происходит вот что: координата метки Event Start приравнивается к координате начала выбранного региона, а координата Event End приравнивается к координате его окончания.
А сейчас вернемся к рассмотрению режимов циклической записи аудиосообшений. 
Командой главного меню File > Preferences открывается диалоговое окно, содержащее всевозможные опции Cubase SX. В левой части окна следует выбрать раздел Audio, тогда в правой части окна станут доступными опции, имеющие отношение к записи звука (рис. 4.40). 
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Рис. 4.40. Окно Preferences, раздел Audio
Среди них имеется список Cycle Record Mode (режим циклической записи). В нем можно выбрать один из трех режимов циклической записи звука. 

·  Create Regions — при каждом очередном проходе цикла внутри аудиосообщения будет создаваться новый регион. В результате прохода нескольких циклов будет записано многослойное аудиосообщение, а на поверхности (воспроизводимым) будет тот регион, что был записан в последнюю очередь; 

·  Create Events — при каждом проходе цикла будет создаваться новое аудиосообшение. В результате аудиосообщения окажутся наслоенными друг на друга; 

·  Create Events + Regions — комбинация первых двух режимов. В результате циклической записи будут создаваться новые аудиосообщения. А в каждом из аудиосообщений будут создаваться регионы, соответствующие каждому из проходов цикла. В результате записи N проходов цикла у вас образуется N практически одинаковых аудиосообщений, каждое из которых будет содержать N регионов. 

Может создаться впечатление, что последний способ является расточительным из-за того, что общее число регионов окажется равным N в квадрате. Однако в действительности все сообщения будут создаваться на базе одного и того же звукового файла (все сообщения будут содержать ссылку на один и тот же файл). А для хранения в памяти компьютера меток требуется несопоставимо меньше места, чем для хранения аудиоданных. 
Допустим, что вы выполнили циклическую запись фрагмента вокальной партии, и при этом использовался режим Create Regions. В результате у вас образовалось аудиосообщение, содержащее несколько регионов. Каждый из регионов соответствует разным вариантам исполнения партии. С помощью команды контекстного меню Set To Region (о ней мы уже упоминали) вы можете перебирать варианты исполнения. 
Последнее замечание, которое мы хотим сделать относительно циклической записи, — следите за тем, чтобы кнопка [image: image166.png]


(punch out) на транспортной панели не оказалась случайно нажатой. Иначе после первого прохода цикла программа выйдет из режима записи, и дальше будет продолжаться циклическое воспроизведение.

4.4.4. Привязка графических объектов, первое знакомство с квантизацией

Все операции по перемещению любых графических объектов и частей, в частности, выполняются с помощью мыши. Однако разрешающая способность любого манипулятора ограничена. Без специальных средств было бы очень трудно, например, совместить начало перемещаемой части с началом такта в том масштабе, в котором выполняется основная работа в секции треков. 
Средство это существует во многих редакторах, включая Cubase SX. Называется оно Snap (привязка). 
Режим привязки включается кнопкой [image: image167.png]


(Snap), расположенной на панели инструментов окна проекта. Справа от этой кнопки расположено поле Snap Mode Selector (выбор режима привязки), показанное на рис. 4.41. Щелчком на нем открывается меню, содержащее различные режимы привязки. Каждый режим имеет свое графическое обозначение и название. Перечислим их. 

·  Grid [image: image168.png]


— привязка к узлам невидимой сетки; 

·  Events [image: image169.png]


— привязка к границам (началам и окончаниям) сообщений; 

·  Shuffle [image: image170.png]


— режим "перетасовки", при котором перемещаемые части или аудиосообщения могут следовать только друг за другом; 

·  Magnetic Cursor ( [image: image171.png]


) — привязка к указателю текущей позиции; 

·  Grid + Cursor ([image: image172.png]


) — комбинация режимов Grid и Magnetic Cursor; 

·  Events + Cursor ( [image: image173.png]2 G



) — комбинация режимов Events и Magnetic Cursor; 

·  Events + Grid + Cursor ( [image: image174.png]H T



) — комбинация режимов Events, Grid и Magnetic Cursor. 
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Рис. 4.41. Поля Mode Selector, Grid Selector, Quantize Setup (слева направо)
Наиболее универсальным можно считать режим Grid. Когда он включен, перемешаемые пользователем графические объекты (включая локаторы) "прилипают" к узлам невидимой сетки. Шаг сетки задается в поле Grid Selector, расположенном справа от поля Snap Mode Selector (рис. 4.41):  

·  Ваr — использовать шаг сетки, равный такту;  

·  Beat — использовать шаг сетки, равный доле; 

·  Use Quantize — использовать шаг сетки такой же, как и шаг квантизации.  

Квантизация предназначена для коррекции неидеальности "живой" игры музыканта. Понятие квантизации бок о бок идет с понятием привязки объектов к сетке, но применяется квантизация только к сообщениям типа Note (сообщение о нажатии MIDI-клавиши). 
Традиционная квантизация — это привязка начальных позиции и протяженности сообщения типа Note к узлам невидимой сетки, расположенной вдоль оси времени, поэтому моменты возникновения и длительности звуков будут кратны шагу сетки. С точки зрения пользователя квантизация выглядит так: выделяете одну или несколько MlDl-частей (или отдельные сообщения внутри части) и подаете специальную команду. После этого начала или длительности нот (в зависимости от команды) притягиваются к ближайшим узлам сетки. Существует еще режим автоматической квантизации, включаемый кнопкой AQ, расположенной на транспортной панели. В этом режиме квантизации будут подвергаться все записываемые сообщения типа Note. 
Шаг квантизации выбирается в меню, вызываемом щелчком на поле Quantize Selector (рис. 4.41), расположенном справа от поля Grid Selector. Кроме стандартных пресетов, в данном меню вы можете выбрать команду Setup, открывающую окно диалога Quantize Setup. В данном окне вы можете более тонко настроить работу квантизации. В частности, можно сделать привязку нот к узлам сетки нежесткой. Это позволит частично сохранить неидеальность живой игры и тем самым избежать ощущения "компьютерности". 
Подробно о квантизации мы расскажем в главе 6. 
В завершение раздела заметим, что если включен режим привязки к сетке, то это распространяется и на объекты, создаваемые при записи (части и аудиосообщения). 

4.4.5. Операции над частями и аудиосообщениями

Над частями и аудиосообщениями можно производить какие угодно операции: перемещать, разрезать, копировать, удалять, объединять и т. д. Но для того чтобы выполнять какие-либо действия над объектами проекта, предварительно их следует выделить. 

Выделение

В верхней области секции треков имеется панель инструментов. Проверьте, чтобы кнопка [image: image176.png]


(Object Selection) на панели инструментов окна проекта быть нажата — это означает, что курсор мыши будет работать как инструмент для выделения и перемещения графических объектов. Чтобы выделить одну часть или аудиосообщение, достаточно щелкнуть на нем кнопкой мыши. Чтобы снять выделение, нужно щелкнуть на любом свободном месте секции треков. 
Группа треков выделяется следующим образом. С помощью курсора мыши, словно в графическом редакторе, рисуется прямоугольник, полностью охватывающий те части и аудиосообщения, которые следует выделить. Охваченные этим прямоугольником объекты оказываются выделенными (рис. 4.42, а, б, в). Еще один способ выделения нескольких частей: нажмите и удерживайте нажатой кнопку <Shift>, затем "перещелкайте" нужные части. Если вам требуется выделить все объекты, расположенные на одном треке, то для этого существует специальная команда. Щелкните правой кнопкой мыши на поле нужного трека в списке треков, возникнет контекстное меню трека, в котором следует выбрать команду Select All Events. В главном меню Cubase SX имеется большой набор команд для выделения объектов проекта. Все они собраны в подменю Edit > Select. Перечислим те из них, что доступны из окна проекта: 

·  All — выделить все объекты (сочетание клавиш <Ctrl> + <A>); 

·  None — снять выделение со всех объектов (сочетание клавиш <Ctrl> + <Shift> + <A>); 

·  In Loop — выделить все объекты, полностью или частично попадающие в область между левым и правым локаторами; 

·  From Start to Cursor — выделить все объекты, расположенные на интервале от начала проекта до указателя текущей позиции; 

·  From Cursor to End — выделить все объекты, расположенные после указателя текущей позиции; 

·  All on Selected Tracks — выделить все объекты на выделенных треках. 
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Рис. 4.42. Выделение группы аудиосообщений
Чтобы выделить сразу несколько треков, следует "перещелкать" их поля в списке треков, удерживая нажатой клавишу <Ctrl>. Альтернативный вариант — щелкнуть на поле первого трека, входящего в группу выделяемых треков, затем, удерживая нажатой клавишу <Shift>, щелкнуть на поле последнего трека группы. 

Удаление, отмена последней операции

Самая простая операция с выделенными объектами (частями или аудиосообщениями) — их удаление — выполняется нажатием клавиши <Delete> или <Backspace>, либо командой главного меню программы Edit > Delete, либо командой Edit > Delete контекстного меню, вызываемого щелчком правой кнопкой мыши на области секции треков, содержащей части или аудиосообщения. 
Но и это еще не все. На панели инструментов окна проекта имеется кнопка [image: image178.png]


(Erase) — ластик. Если данная кнопка нажата, то щелчок на объекте приводит к его удалению. 
Отменить удаление (как и любую другую последнюю из операций, выполненных над объектами проекта) можно командой главного меню Edit > Undo или нажав комбинацию клавиш <Ctrl> + <Z>. В отличие от предыдущих версий Cubase, в Cubase SX поддерживается бесконечное количество отмен (вплоть до первой операции в сеансе работы с проектом). Однако существуют и такие операции, которые не могут быть отменены в принципе. На невозможность отмены мы будем обращать ваше внимание особо. 
Если вы уже воспользовались командой Edit > Undo, то имеется возможность ее отменить (вернуть все в то состояние, которое было до ее выполнения). Для этого существует команда Edit > Redo (клавиши <Ctrl> + <Shift> + <Z>). Еще одна команда, связанная с рассматриваемой темой, — Edit > History, вызывает окно диалога Edit History (история редактирования). В данном окне присутствует список всех команд, которые были выполнены в текущем сеансе работы с проектом. Если вы хотите отменить сразу несколько команд, то вместо того, чтобы многократно подавать команду Edit > Undo, удобнее щелкнуть на нужной команде в истории. Ваш проект незамедлительно перейдет в то состояние, в котором он находился после команды, выбранной вами в списке. Это похоже на путешествие во времени. Однако в отличие от машины времени возможности Cubase SX вполне реальны. Причем вы можете путешествовать по истории редактирования как назад, так и вперед (естественно, только до тех команд, которые вы реально подавали). Почему "естественно"? Потому, что настоящей машины времени все же не существует и Cubase SX не может знать того, какие команды вы будете подавать в будущем. 

Перемещение

Чтобы переместить одиночный объект, не обязательно его предварительно выделять. Хватайте его и тащите на нужное место (при условии, что кнопка [image: image179.png]


на панели инструментов окна проекта нажата). Как только вы захватите объект мышью, он выделится автоматически. 
Если требуется переместить сразу группу объектов, то предварительно все их следует выделить. После этого следует ухватиться за любой из объектов данной группы и перетащить его на новое место. 
При перетаскивании объекты раздваиваются. Вы хватаете объект мышью и тащите, при этом вы перетаскиваете его изображение. Но до тех пор, пока вы не отпустите кнопку мыши и не "положите" объект на новое место, на его старом месте остается копия его изображения. 
Если вам требуется переместить один или несколько объектов за пределы видимой области, то ваши действия должны быть таковыми: 

·  схватите объект(ы) левой кнопкой мыши и подведите курсор к правой или левой границе секции треков, программа начнет перематывать видимую область проекта в соответствующем направлении; 

·  когда появится нужное вам место, отодвиньте курсор от границы вглубь секции треков; 

·  установите перетаскиваемый объект в требуемое место и отпустите левую кнопку мыши. 

Не обязательно перемещать объекты методом Drag and Drop. Вы можете воспользоваться буфером обмена для их перемещения. Скопируйте или вырежьте части и аудиосообщения в буфер обмена, затем вставляйте в требуемое место трека, определяемое указателем текущей позиции. Обратите внимание на то, что объекты всегда вставляются на тот же трек, с которого они были скопированы или вырезаны в буфер обмена. 
Перечислим соответствующие команды главного меню: 

·  Edit > Cut (клавиши <Ctrl> + <X>) — вырезать в буфер (скопировать выделенные объекты в буфер, а исходные копии удалить); 

·  Edit > Сору (клавиши <Ctrl> + <С>) — копировать в буфер;  

·  Edit > Paste (клавиши <Ctii> + <V>) — вставить из буфера; 

·  Edit > Paste at Origin (клавиши <Alt> + <V>) — вставка объектов из буфера обмена на то же место, в котором они находились до копирования или вырезания. 

Не забывайте и о существовании контекстного меню, вызываемого щелчком правой кнопки мыши над секцией треков. В нем продублированы все команды для работы с буфером обмена. 
Будьте внимательны! Все аудиосообщения, хранимые на одном треке, должны иметь одинаковый формат. То есть на одном треке должны храниться или только стереофонические аудиосообщения, или только монофонические. В случае конфликта (когда на одном треке хранятся сообщения разных форматов) какие-то сообщения будут воспроизводиться, а какие-то не будут. 
Кстати, если переместить аудиосообщение или часть в ту область секции треков, где треки отсутствуют, то для этого объекта будет создан новый MIDI- или аудиотрек (в зависимости от типа объекта). 
Обратите внимание на одну деталь. Когда вы осуществляете захват графического объекта и начинаете его перемещать, то перемещение происходит не сразу, а спустя короткий, но ощутимый интервал времени. Задержка нужна для того, чтобы исключить случайное перемещение объектов, когда вы на них щелкаете. За длительность задержки отвечает специальный параметр, называемый Drag Delay. Доступ к нему осуществляется через окно Preferences, вызываемое командой главного меню File > Preferences. Параметр Drag Delay доступен в разделе Editing и задается в миллисекундах. 

Разрезание

Переходим к разрезанию. Что значит выражение "разрезать часть или сообщение"? Все просто: была одна часть, разрезали ее — стало две части. 
Самый простой способ разрезания объектов — с помощью инструмента Split, которому соответствует кнопка [image: image180.png]


на панели инструментов секции треков. Нажмите эту кнопку и попробуйте разрезать несколько частей или аудиотреков, щелкая на них левой кнопкой мыши.
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Рис. 4.43. Разрезание аудиоссобщения
Если включен режим Snap (привязка), то разрезы будут появляться не обязательно там, где вы щелкнули, а в месте, которое соответствует условиям привязки (например, в ближайшем узле сетки). Причем еще до того, как вы разрежете объект, место будущего разреза будет отмечено тонкой горизонтальной линией, а около курсора мыши (в форме ножниц) будет отображаться подсказка с координатами будущего разреза (рис. 4.43, а). 
После щелчка левой кнопкой мыши на границе раздела возникнет синяя линия — соприкасающиеся гранимы двух новых объектов. Теперь можно воспользоваться инструментом [image: image182.png]


и отнести один из отрезанных объектов на новое место (рис. 4.43, б).
Если вам требуется разрезать сразу несколько частей, расположенных на разных треках, то удобнее воспользоваться командой главного меню Edit > Split at Cursor (клавиши <Alt> + <X>), которая выполняет разрезание предварительно выделенных объектов по линии указателя текущей позиции проекта. Аналогичная команда имеется и в контекстном меню аудиосообщений. 
Стоит упомянуть еще об одной команде главного меню: Edit > Split Loop. Аналогичная команда тоже имеется и в контекстном меню секции треков. В данном случае разрезание объектов произойдет по границам области проекта, определяемой положениями левого и правого локаторов.
Интересную особенность имеет разрезание аудиосообщений. Как мы уже говорили, аудиосообщение — это ссылка на звуковой файл и набор атрибутов. Когда вы разрезаете аудиосообщение, то в результате получаются два новых аудиосообщения, каждое из которых ссылается на один и тот же звуковой файл. С самим файлом не производится никаких операций. В дальнейшем вы можете раздвинуть границы аудиосообщений на всю длину этого файла. В этом случае у вас получится два абсолютно одинаковых аудиосообщения и не останется никаких следов разреза. 
А теперь настало время поговорить о перемещении границ аудиосообщений и частей.

Склеивание, заполнение пауз

Склеить несколько объектов в один достаточно просто. Делается это с помощью инструмента [image: image183.png]


(Glue), расположенного на панели инструментов окна проекта. Вы просто щелкаете на нужной части или по аудиосообщению, и данный объект сливается со следующим за ним на треке объектом. Причем совершенно неважно, на каком расстоянии друг от друга расположены склеиваемые объекты. 
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Рис. 4.44. Склеивание двух объектов
Склеивание проиллюстрировано рис. 4.44, а, б. Следует сделать замечание относительно склеивания аудиосообщений. Дело в том, что как такового склеивания аудиосообщений не происходит. В результате "склеивания" аудиосообщения объединяются в одну часть, но по своей сути остаются разными сообщениями. Если вы захотите их объединить в одно сообщение, то следует их выделить (достаточно выделить часть, в которой они находятся) и воспользоваться командой главного меню Audio > Bounce Selection. Но прибегать к данной команде стоит лишь в том случае, когда это действительно необходимо. Данная команда относится к категории разрушающего редактирования. На основании выделенных аудиосообщений рассчитывается новое сообщение, которое заменяет собою исходные. При этом учитываются все атрибуты исходных сообщений (амплитудная огибающая, метки начала и окончания сообщения и др.). Перед заменой аудиосообщений на вновь рассчитанное будет выдано соответствующее предупреждение, и вы можете отказаться от своей затеи.
В данном разделе стоит упомянуть еще об одной интересной команде Cubase SX, позволяющей заполнять паузы между аудиосообщениями. Команда вызывается из главного меню Audio > Close Gaps (аналогичная команда имеется и в контекстном меню аудиосообщений) и работает применительно к выделенному сообщению, за которым следует пауза. Допустим, у нас имеется два аудиосообщения, расположенные так, как показано на рис. 4.44, а. С помощью упомянутой команды можно было бы заполнить пустое пространство между ними за счет растяжения левого сообщения. Правда, в данном случае применять ее нет смысла, но при использовании лупов и грувов (см. главу 12) она бывает незаменимой. 

Копирование

Как мы уже говорили, основной способ копирования частей и аудиосообщений — копирование через буфер обмена: команды Edit > Copy (копировать в буфер) и Edit > Paste (вставить из буфера) главного меню или контекстного меню секции треков. Аналогичные команды имеются в подавляющем большинстве приложений Windows, и вы наверняка знаете, как ими пользоваться. Больший интерес представляют специфические команды копирования, которые есть только в Cubase SX. 
Начнем с рассмотрения довольно простой команды Edit > Duplicate. Она создает копию выделенного объекта, которая располагается следом за ним. Эту и следующие команды копирования можно применять одновременно к нескольким объектам, которые могут располагаться даже на разных треках.
Если требуется размножить выделенные сообщения в больших количествах, удобнее воспользоваться командой Edit > Repeat (ее можно вызвать сочетанием клавиш <Ctrl> + <K>). Откроется диалоговое окно Repeat Events, в котором следует указать, сколько копий выделенных объектов следует сделать (параметр Count), и при необходимости установить флажок Shared. После нажатия кнопки ОК предварительно выделенные объекты будут размножены и размещены последовательно друг за другом. Если был установлен флажок Shared, то все эти объекты окажутся связанными между собою: любое изменение одного из связанных объектов повлечет аналогичные изменения во всех его копиях. Визуально связанные объекты отличаются от нормальных наличием символа [image: image185.png]


. Чтобы развязать объекты, следует выделить их и воспользоваться командой Edit > Convert to Real Copy. В случае применения этой команды к связанным аудиосообщениям, будут созданы копии использованных в них звуковых файлов. 
Еще более интересна команда копирования: Edit > Fill Loop. Она выполняет многократное копирование выделенных объектов таким образом, чтобы заполнить копиями область проекта, ограниченную левым и правым локаторами. 
Применение любых команд копирования к аудиосообщениям приводит к созданию связанных копий. Чтобы развязать их, пользуйтесь командой Edit > Convert to Real Copy. 

Инструмент Range Selection

На панели инструментов окна проекта имеется кнопка [image: image186.png]


(Range Selection). С помощью данного инструмента, так же как и с помощью инструмента [image: image187.png]


(Obiect Selection), можно выделять объекты, расположенные в секции треков. Однако с помощью инструмента [image: image188.png]


объекты можно выбирать целиком. 
Вам не удастся выбрать половину какой-нибудь части или аудиосообщения. Инструмент [image: image189.png]


(Range Selection), как и следует из его названия, позволяет выбрать прямоугольную область в секции треков, включающую в себя как целые объекты, так и их фрагменты. Над всем, что попадет в данную область, можно выполнять любые действия: копирование или вырезание в буфер обмена, перемещение, удаление. 
Если задействован инструмент [image: image190.png]


(Range Selection), то в вашем распоряжении оказываются еще две специальные команды главного меню для выделения объектов:  

·  Edit > Select > Left Selection Side to Cursor (клавиша <Е>) — оставить выделенной только ту часть выделенной области, что находится слева от указателя текущей позиции;  

·  Edit > Select > Right Selection Side to Cursor (клавиша <D>) — оставить выделенной только ту часть выделенной области, что находится справа от указателя текущей позиции. 

На рис. 4.45 приведен пример использования данного инструмента. У нас имеется два аудиосообщения, расположенные на разных треках. Мы подводим курсор к углу области, которую хотим выделить (рис. 4.45, а). Удерживая нажатой левую кнопку мыши, выделяем прямоугольную область. Даже после того как вы отпустите кнопку мыши, в любой момент вы можете передвинуть границы выделенной области, ухватившись за них мышью. А если ухватиться мышью за саму область (рис. 4.45, б), то ее можно перетащить в любое место проекта. В процессе перемещения, пока левая кнопка мыши удерживается нажатой, около курсора будет отображаться позиция левой границы перемещаемой области (рис. 4.45, в). После завершения перемещения (когда вы отпустите левую кнопку мыши), вы обнаружите, что вместе с областью переместились и вес объекты (и даже их фрагменты!), которые изначально присутствовали в ней (рис. 4.45, <?). 
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Рис. 4.45. Применение Range Selection
В главном меню программы существует подменю Edit > Range, содержащее набор команд, работающих совместно с инструментом [image: image192.png]


(Range Selection). Перечислим эти команды: 

·  Cut Time (клавиши <Ctrl> + <Shift> + <Х>) — вырезать все, что оказалось в выделенной области, в буфер обмена; передвинуть все, что оказалось справа от вырезанной области, так", чтобы заполнить образовавшийся пробел; 

·  Delete Time * (<Shift> + <Backspace>) — команда похожа на предыдущую, но происходит не вырезание, а удаление выделенной области; 

·  Paste Time * (<Ctrl> + <Shift> + <V>) — вставить фрагмент проекта из буфера обмена; вставка осуществляется начиная с левой границы выделенной области; все, что находится на месте вставки, сдвигается вправо (чтобы освободить место под вставляемый фрагмент); 

·  Paste Time at Original * — команда аналогична предыдущей, но вставка фрагмента проекта из буфера происходит начиная с той позиции, в которой данный фрагмент находился прежде, чем попасть в буфер; 

·  Split (<Shift> + <X>) — разрезать объекты по границам выделенной области; 

·  Crop — передвинуть границы объектов, частично попавших в выделенную область, таким образом, чтобы их границы совпадали с границами выделенной области; 

·  Insert Silence * (<Ctrl> + <Shift> + <E>) — освободить выделенную область за счет перемещения вправо всех объектов, попавших в нее.  

Команды, которые мы пометили символом "*", могут работать совместно с инструментом [image: image193.png]


(Object Selection). Вместо области проекта, выделенной инструментом [image: image194.png]


(Range Selection), где нужно, используется область проекта, ограниченная левым и правым локаторами. При описании команды Edit > Range > Crop мы упомянули возможность перемещения границ объектов (частей и аудиосообщений). Подробно мы поговорим об этом чуть позже. 

Амплитудные огибающие аудиосообщений; пересечение аудиосообщений, Auto Fades, Auto Crossfades

В пределах каждого из аудиосообщений вы можете сформировать амплитудную огибающую. Никаких специальных команд для того, чтобы создать эту огибающую, подавать не нужно. Она является неотъемлемым свойством аудиосообщения и присутствует в нем изначально. Правда, форма этой огибаюшей по умолчанию такова, что она никак не влияет на звучание аудио-сообщения: фазы атаки и затухания отсутствуют, громкость соответствует нормальной громкости звучания сообщения. 
Амплитудная огибающая аудиосообщения имеет три фазы: Fade In (возрастание громкости), поддержка (громкость не изменяется) и Fade Out (спад громкости). Каждой из фаз соответствует свой узел. По- умолчанию узлы расположены следующим образом: 

·  узел Fade In — в левом верхнем углу графического объекта аудиосообщения; 

·  узел поддержки — в центре на верхней границе;  

·  узел Fade Out — в правом верхнем углу. 
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Рис. 4.46 (а-г). Формирование амплитудной огибающей аудиосообщения
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Рис. 4.46 (д, е). Формирование амплитудной огибающей аудиосообщения
Немного практики. С помощью инструмента [image: image197.png]


хватаемся за узел Fade In (рис. 4.46, а) и тащим его вправо (4.46, 6). При этом около курсора отображается подсказка, в которой указана позиция завершения фазы Fade In (относительно начала временной оси проекта) и ее длительность (относительно начала аудиосообщения).
Хватаемся за узел фазы поддержки и тащим его вниз (рис. 4.46, в). Около курсора отображается следующая подсказка: максимально возможный уровень сигнала в аудиосообщении в фазе поддержки, а в скобках — изменение амплитуды по сравнению с последней редакцией огибающей. 
После того как мы перетащим узел Fade Out влево, получится примерно то, что показано на рис. 4.46, г. В процессе формирования амплитудной огибающей вы увидите, как соответствующим образом изменяется волновая форма, отображающаяся внутри прямоугольника-аудиосообщения.
В своем примере мы перемещали узел поддержки вниз, уменьшая тем самым общую громкость аудиосообщения. Однако данный узел можно перемещать и вверх (за пределы графического объекта аудиосообщения): хватаемся за узел поддержки (рис. 4.46, д) и тащим его вверх (рис. 4.47, в). При этом сам узел и огибающая не выйдут за верхнюю границу прямоугольника аудиосообщения, но фактическая громкость будет увеличиваться. 
Операция формирования амплитудной огибающей относится к категории неразрушающего редактирования: в аудиофайл, содержащий исходный сэмпл, не вносится никаких изменений. Отрезки аудиосообшений. содержащие переходы Fade In и Fade Out, рассчитываются сразу после того, как вы закончили перемещать соответствующие узлы и отпустили кнопку мыши. Результаты расчетов сохраняются во временных файлах, находящихся в папке <Ваш проект>/Fades. Во время воспроизведения соответствующие фрагменты исходного звукового файла подменяются на эти временные файлы, заготовленные заранее. Такой подход, видимо, позволяет снизить загрузку процессора во время воспроизведения проекта. Кстати, амплитудные огибающие на фазах Fade In и Fade Out могут иметь очень сложную форму, и задавать ее можете вы. Выделим одно или несколько аудиосообщений и воспользуемся командой главного меню Audio > Open Fades Editor(s). Аналогичная команда имеется и в контекстном меню аудиосообщений. А работает она так: если хотя бы у одного из выделенных сообщений длительность фазы Fade In отлична от нуля, откроется окно Fade In, показанное на рис. 4.47, а, если хотя бы у одного из выделенных сообщений длительность фазы Fade Out отлична от нуля, откроется окно Fade Out, показанное на рис. 4.47, б. 
Как видно из рис. 4.47, оба окна очень похожи друг на друга, за исключением того, что одно предназначено для редактирования огибающей в фазе Fade In, а другое — в фазе Fade Out. 
Основным элементом этих окон является поле с изображением волновых форм и огибающей на участке Fade In или Fade Out. Светло-серым цветом отображается исходная волновая форма, темно-серым — волновая форма, которая будет получена за счет применения амплитудной огибающей. С помощью мыши вы можете придать огибающей произвольную форму, расставляя в нужных местах узлы. В верхней части окон имеются две кнопки, определяющие способ интерполяции (соединения) узлов: 
[image: image198.png]


  (Spline Interpolation) — интерполяция узлов по методу сплайнов (кривая проходит сквозь все узлы, ее крутизна в целом минимизирована). [image: image199.png]


(Linear Interpolation) — интерполяция полиномом первого порядка (кривая представляет собой набор отрезков, границами которых являются узлы). 
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Рис. 4.47. Редактирование Fade In и Fade Out
С помощью кнопок [image: image201.png]


или [image: image202.png]


выбираются различные предустановки огибающей. Если вы нажмете одну из этих кнопок, то все имеющиеся узлы будут удалены, а вместо них будут созданы новые, расположенные таким образом, чтобы кривая имела форму, показанную на соответствующей кнопке. 
Изменения, внесенные в форму огибающей, вступят в силу после нажатия кнопки ОК или Apply, но пока этого не произошло, нажатием кнопки [image: image203.png]


(Restore) можно сбросить все настройки и вернуть действующую в данный момент форму огибающей (ту форму огибающей, которой обладает аудиосообщение). 
После нажатия кнопки As Default, у всех вновь создаваемых аудиосообще-ний амплитудная огибающая в фазе Fade In или Fade Out будет иметь такую же форму, как и та, что присутствует на момент нажатия в окне Fade In или Fade Out. 
Естественно, вы можете сохранять и впоследствии загружать свои собственные формы огибающей в виде пресетов. Для этого предназначена стандартная для Cubase SX группа Presets. 
Как видите, можно сформировать сколь угодно сложную амплитудную огибающую, но только на участках Fade In или Fade Out. А что делать, если требуется сформировать сложную огибающую где-то посредине аудиосообщения? В этом случае можно растянуть фазу Fade In или Fade Out на нужную длину (вплоть до того, чтобы охватить все сообщение) и отредактировать форму амплитудной огибающей. При этом стоит иметь в виду, что крайние точки огибающей в фазах Fade In и Fade Out имеют фиксированные значения. Например, фаза Fade In всегда начинается с нулевого уровня сигнала и заканчивается максимальным уровнем сигнала. 
Если требуется выполнить плавный переход от одного сообщения к другому, то сделать это можно, разместив аудиосообщения на разных треках так, чтобы они нахлестывались во времени (рис. 4.48). У одного сообщения нужно сформировать Fade Out, а у другого — Fade In так, чтобы одно сообщение плавно затихало, а второе плавно набирало громкость. Этим способом следует пользоваться в том случае, когда пересекающиеся аудиосообщения имеют разный формат (одно — стерео, другое — моно). 
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Рис. 4.48. Пересечение двух аудиосообщений во времени
Однако в большинстве случаев удобнее, если пересекающиеся сообщения расположены на одном треке. Как мы уже говорили, в случае пересечения нескольких аудиосообщений на одном треке, они оказываются как бы одно над другим. В каждый момент воспроизводится то сообщение, которое оказалось над всеми остальными. Тем не менее, организовать плавный переход от одного аудиосообшения к другому можно, даже если они находятся на одном треке. При этом сообщения должны иметь одинаковый формат (оба сообщения или моно, или стерео). 
Проделаем следующее. Расположим два аудиосообщения "внахлест" так, как показано на рис. 4.49, а. Область пересечения двух аудиосообщений окрашена темно-серым цветом. Проследите за тем, что хотя бы одно из пересекающихся аудиосообщений было выделено. Теперь воспользуемся командой главного меню Audio > Crossfade (или аналогичной командой контекстного меню секции треков). В результате область пересечения аудиосообщенй 
получит особый статус и будет выглядеть примерно так, как показано на рис. 4.49, б. Даже из рисунка видно, что пересекающиеся аудиосообщения плавно переходят одно в другое. На рис. 4.49, а область пересечения фактически принадлежала правому сообщению, именно оно и воспроизводилось, т. к. было выше левого сообщения. На рис. 4.49, б волновая форма области пересечения отличается: в ней присутствуют черты не только второго сообщения. 
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Рис. 4.49. Взаимопроникновение аудиосообщений и перемещение границ Crossfade
Если сделать двойной щелчок на области пересечения или повторно воспользоваться командой Audio > Crossfade, то возникнет диалоговое окно Crossfade, показанное на рис. 4.50. 
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Рис. 4.50. Диалоговое окно Crossfade
В окне Crossfade вы можете отредактировать амплитудные огибающие аудиосообщений в области их пересечения подобно тому, как это делается в окнах Fade In и Fade Out (рис. 4.47). Естественно, окно Crossfade имеет присущие только ему элементы. В нижней части окна расположено поле. в котором отображается волновая форма, получающаяся в результате пересечения аудиосообщений. Светлыми линиями в этом поле показаны амплитудные огибающие каждого из сообщений в отдельности, а синей линией — результирующая амплитудная огибающая. Если в точке пересечения светлых линий она имеет провал, то это означает следующее: одно аудиосообщение слишком сильно затихает еще до того, когда второе аудиосообщение успеет набрать громкость. Если синяя линия имеет подъем, то это означает: второе сообщение набирает громкость еще до того, как первое существенно затихает. Прямая синяя линия — гарантия плавности перехода. 
Кнопки Play Fade позволяют прослушать звучание каждого из аудиосообщений на участке пересечения с учетом амплитудной огибающей. Кнопки Play Dry позволяют прослушать эти же участки аудиосообщений, но без учета амплитудной огибающей. Кнопка Play запускает воспроизведение результирующей волновой формы. 
Опции Equal Power и Equal Gain включают особый режим редактирования амплитудных огибающих. Они становятся как бы связанными между собой. Изменение огибающей одного сообщения влечет за собой изменение огибающей другого сообщения. 
В режиме Equal Power вы можете только перемещать единственный узел по горизонтали. Формы огибающих от вас не зависят. Они таковы, чтобы обеспечить постоянство энергии результирующей волновой формы на всем участке пересечения (при условии, что волновые формы пересекающихся сообщений имеют равные энергии). 
В режиме Equal Gain вы можете задать какую угодно форму амплитудной огибающей для одного из аудиосообщений. Но форма огибающей другого сообщения всегда будет симметрична ей, и результирующая огибающая (синяя линия) всегда будет прямой. В группе Length вы можете изменить длительность фазы перехода одного сообщения в другое. Однако удобнее всего сделать это из окна проекта: хватаетесь за границу области Crossfade и тащите ее в нужном направлении (рис. 4.49, в). В действительности границы области Crossfade есть не что иное, как границы аудиосообщений. Если продолжать перемещение границы зоны Crossfade, то при ее выходе из зоны пересечения аудиосообщений эта зона исчезнет, а вы обнаружите, что ухватились за границу аудиосообщения (рис. 4.49, г). 
С помощью команды главного меню Audio > Remove Fades можно привести амплитудную огибающую одного или нескольких выделенных аудиосообшений в состояние, принятое по умолчанию, т. е. фактически удалить ее. 
Если не принимать никаких специальных мер, то на границах аудиосообщений (особенно после перемещения границ или разрезания аудиосообщений) при воспроизведении могут возникать щелчки. Допустим, вы разрезаете аудиосообщение на границе музыкального такта. Чему равно значение звукового отсчета в этом месте? Скорее всего, это не 0, т. к. вероятность этого очень мала. Представьте, как отсчет за отсчетом воспроизводится волновая форма аудиосообщения. Воспроизводится последний звуковой отсчет, значение которого отлично от 0. Но воспроизведение проекта на этом не заканчивается, и вместо отсутствующих отсчетов аудиосообщений начинают воспроизводиться звуковые отсчеты, значение которых равно 0: на границе аудиосообщения происходит резкий перепад от ненулевых значений отсчетов к нулю. Если сразу за аудиосообщением следует другое, то ситуация может еще более усугубиться, так как перепад может быть еще большим (от одного ненулевого значения к другому, с противоположным знаком). Чем больше перепад, тем громче щелчок. Чтобы его избежать, в профессиональных музыкальных и звуковых редакторах используются функции Auto Fades. Они могут называться и по-другому, но их суть от этого не меняется. Когда аудиосообщение начинает воспроизводиться, за короткий промежуток времени его громкость относительно плавно возрастает от 0 до нормального значения. А за небольшой промежуток времени до завершения аудиосообщения его громкость начинает плавно уменьшаться до 0. Резкие перепады отсутствуют, отсутствуют и щелчки.
В Cubase SX дело обстоит аналогичным образом. Если на одном треке пересекаются во времени два и более аудиосообщений и для них не применяется функция Crossfade, то звучать будут только те сообщения, которые в каждый конкретный момент расположены на поверхности экрана. А чтобы избежать щелчков на границах разделов между сообщениями, применяется функция Auto Crossfades. По своей сути она аналогична функции Crossfade. но применяется обычно на очень коротком промежутке времени. Параметры функций Auto Fades и Auto Crossfades можно контролировать на двух уровнях: на уровне проекта и на уровне отдельных треков. Командой главного меню Project > Auto Fades Settings вызывается окно диалога Auto Fades, содержащее настройки функций Auto Fades и Auto Crossfades, действующие для всего проекта в целом. Если же щелкнуть правой кнопкой мыши на поле какого-то аудиотрека в списке треков, а затем выбрать в контекстном меню команду Auto Fades Settings, то тогда также откроется диалоговое окно Auto Fades (рис. 4.51), но его настройки будут относиться только к конкретному треку. 
В правой верхней части данного окна расположены три переключателя, с помощью которых осуществляется включение описанных выше функций (Auto Fade In, Auto Fade Out, Auto Crossfades). В поле Length задается длительность переходов (от 1 до 500 мс). Если нажать кнопку As Default, то все настройки, выполненные в данном окне, будут использоваться при создании новых проектов. 
Если включена опция Use Project Settings, то применительно к треку, для которого было вызвано данное диалоговое окно, будут использоваться глобальные настройки Auto Fade In, Auto Fade Out, Auto Crossfades, относящиеся ко всему проекту, а все настройки, выполненные в рассматриваемом окне, будут относиться к категории глобальных (распространяться на весь проект). В аналогичном окне, вызываемом командой Project > Auto Fades Settings, данная опция отсутствует, потому что настройки этого окна и так распространяются на весь проект. Итак, какие же настройки доступны? В окне Auto Fades имеются две вкладки: 

·  Fades (рис. 4.51, а) — параметры функций Fade In и Auto Fade Out;  

·  Crossfades (рис. 4.51, б) — параметры функции Auto Crossfades. 

Все элементы, расположенные на этих вкладках, вам уже знакомы по окнам Fade In, Fade Out и Crossfade. С их помощью вы можете сформировать огибающую, используемую для модуляции амплитуды аудиосообщений при работе функций Fade In, Auto Fade Out и Auto Crossfades. Эти огибающие нигде не представлены в графическом виде (функции прозрачны для пользователя). Нужно просто помнить о том, что они применяются для обработки "пограничных" отсчетов аудиосообщений, и знать, где конфигурируются их параметры. 
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Рис. 4.51. Диалоговое окно Auto Fades
Следует заметить, что при использовании функций Fade In, Auto Fade Out и Auto Crossfades волновые формы у границ аудиосообщений рассчитываются в режиме реального времени в ходе воспроизведения проекта. Это создает дополнительную нагрузку на процессор. Нагрузка эта сравнительно небольшая, и заметить ее можно разве что при большом количестве коротких аудиосообщений. Но, тем не менее, нагрузка эта присутствует.
И еще одно важное замечание. В настройках Cubase SX (окно Preferences, вызываемое командой File > Preferences, раздел Editing) имеется флажок Delete Overlaps (удалять пересечения). По умолчанию он сброшен, но если его установить, то вам не удастся добиться того, чтобы аудиосообщения нахлестывались друг на друга, и, как следствие, вы не сможете воспользоваться командой Audio > Crossfade. Если попробовать переместить одно аудио-сообщение таким образом, чтобы оно пересекалось во времени на одном треке с другим аудиосообщением, то границы последнего будут автоматически перемещены так, чтобы пересечения все равно не произошло. 

Перемещение границ частей и аудиосообщений, алгоритм Time Stretch

В нижних углах прямоугольников, обозначающих части (и MIDI-, и аудио-части) и аудиосообщения, расположены белые узлы (рис. 4.52, а). Ухватившись за них инструментом [image: image208.png]


, а можно перемещать границы частей или аудиосообщений (рис. 4.52, б, в). В момент перемещения границы около курсора отображается подсказка с ее текущей координатой и длительностью части или аудиосообщения в скобках. Границы аудиосообщения — это маркеры, координаты, задаваемые от начала звукового файла и ограничивающие тот фрагмент этого файла, который будет воспроизводиться. Вы никогда не сможете переместить границы аудиосообщения за пределы соответствующего ему звукового файла. 
Совсем другое дело — границы частей (и MIDI-, и аудиочастей). Их вы можете перемещать, как угодно. При этом позиции сообщений, хранимых в частях, изменяться не будут. 
На кнопке [image: image209.png]


(Object Selection) в нижнем правом углу показан треугольник. Это означает, что у соответствующего инструмента имеется несколько функций. Если на кнопке [image: image210.png]


щелкнуть уже после того, как она выбрана (подсвечена голубым цветом), то возникнет меню, в котором для данного инструмента можно выбрать одну из трех функций: 

·  Normal Sizing [image: image211.png]


— нормальное перемещение границ (описано выше); 

·  Sizing Moves Contents [image: image212.png]


— при перемещении любой из границ вместе с нею будет перемещаться и содержимое части или аудиосообщения; 

·  Sizing Applies Time Stretch [image: image213.png]


— при перемещении любой из границ будет происходить растяжение или сжатие во времени (в зависимости от направления перемещения) содержимого части или аудиосообшения. 
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Рис. 4.52. Изменение границ аудиосообщения
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Рис. 4.53. Перемещение границы аудиосообщения вместе с его содержимым
Около названий функций в скобках приведены соответствующие виды кнопки Object Selection. По умолчанию установлен режим Normal Sizing [image: image216.png]


. С ним вы уже знакомы. 
 На рис. 4.53 проиллюстрирован режим Sizing Moves Contents [image: image217.png]


. Мы ухватились за левую границу аудиосообщения и потащили ее направо (рис. 4.53, а). Вместе с границей стала перемещаться и волновая форма (рис. 4.53, б). 
Особый интерес представляет режим Sizing Applies Time Stretch [image: image218.png]


. Если изменять границы части, содержащей MIDI-сообщения, то позиции этих сообщений на оси времени и длительности будут изменяться пропорционально изменению длительности части. Все сообщения будут "вписаны" в новые границы части.
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Рис. 4.54. Изменение длительности звучания сэмпла без изменения высоты тона
Если же режим Sizing Applies Time Stretch [image: image220.png]


применяется к аудиосообщению или к части, содержащей аудиосообщения, то по отношению к сэмплам будет применяться один из алгоритмов, известных под общим названием алгоритмы Time Stretch (изменение длительности звучания сэмпла без изменения высоты его тона). Алгоритмы будут применяться таким образом, чтобы вписать сэмплы в границы аудиосообшения или части. Пример: хватаемся за границу аудиосообшения (рис. 4.54, а) и переносим ее в горизонтальном направлении (рис. 4.54, б). После того как граница будет "отпущена", возникнет диалоговое окно Processing (рис. 4.55), в котором будет отображаться ход обработки. После завершения обработки длительность сэмпла изменится (рис. 4.54, в), но не изменится его тон и содержание. Если сэмпл содержит вокальную партию, то изменится темп ее исполнения, но не изменится ее тональность. 
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Рис. 4.55. Процесс обработки звуковых данных
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Рис. 4.56. Параметры работы алгоритма Time Stretch
Естественно, незаметной работа данного алгоритма останется только при небольшом в процентном соотношении изменении длительности сэмпла. 
Кроме того, качество работы алгоритма зависит еще и от его параметров, которые доступны в диалоговом окне Preferences в разделе Time Stretch Tool (рис. 4.56). Напомним, что данное окно вызывается командой главного меню File > Preferences. 
В списке Algorithm выбирается конкретный тип алгоритма Time Stretch: МРЕХ Algorithm, Timebandit, ТВ - Drum (по умолчанию). Нельзя сказать, что какой-то определенный алгоритм лучше других. Просто они разные, для одного сэмпла лучше подходит один алгоритм, для другого — другой. Алгоритм ТВ - Drum ориентирован на работу с ударными звуками (барабанными лупами). 
Под списком Algorithm расположен регулятор, с помощью которого изменяется значение параметра Accuracy. Минимальное значение Accuracy (-5) соответствует оптимизации алгоритма под тональные звуки, а максимальное значение (5) — оптимизации под ритмические звуки. Данный параметр используется только алгоритмом Timebandit. 
Если включена опция Always use Drum Mode for Close Gaps, то независимо от того, какой алгоритм выбран в списке Algorithm, для выполнения команды главного меню Audio > Close Gaps будет использоваться алгоритм ТВ -Drum. Напомним, что данная команда нужна для заполнения промежутков между выделенными аудиосообщениями. Заполнение осуществляется как раз за счет растяжения аудиосообщений с использованием алгоритмов Time Stretch. 
Следует отметить, что в Cubase SX существует еще команда главного меню Audio > Process > Time Stretch (ее эквивалент в контекстном меню секции треков команда Process > Time Stretch). Данная команда тоже позволяет изменять длительность предварительно выделенных аудиосообщений. Однако в большинстве случаев удобнее пользоваться именно инструментом Sizing Applies Time Stretch [image: image223.png]


. В обоих случаях доступны одни и те же алгоритмы Time Stretch. Но при использовании команды Audio > Process > Time Stretch вам придется в числовой форме задать степень растяжения/сжатия аудиосообщений. 

Мьютирование и блокирование частей и аудиосообщений

Заглушить можно не только трек (напомним, что делается это включением атрибута Mute), но и отдельные части или аудиосообщения. На панели инструментов главного окна имеется кнопка [image: image224.png]


(Mute). Если воспользоваться данным инструментом и щелкнуть на части или аудиосообщений, то соответствующий объект окажется заглушенным (приобретет светло-серый цвет, не будет воспроизводиться). Чтобы снять атрибут Mute, следует выполнить повторный щелчок по мьютированному объекту. Эти же действия с выделенными объектами можно проделать с помощью команд главного меню Edit > Mute (клавиши <Shift> + <M>) и Edit > Unmute (<Shift> + <U>). Аналогичные команды существуют и в контекстном меню секции треков.
Вы уже знаете, что можно блокировать целые треки. Для этого у каждого трека существует специальный атрибут Lock. Но существует возможность блокирования отдельных частей и аудиосообщений. Блокируемый объект следует выделить и воспользоваться командой главного меню Edit > Lock, или аналогичной командой контекстного меню секции треков, или комбинацией клавиш <Ctrl> + <Shift> + <L>. На изображении части или аудио-сообщения появится символ замка [image: image225.png]


и вы больше не сможете ни переместить данный объект, ни его отредактировать. Если воспользоваться командой Edit > Lock применительно к заблокированному объекту повторно, то откроется окно диалога Lock Event Attributes, в котором будут доступны следующие опции: 

·  Position Locked — блокирована начальная позиция объекта; 

·  Size Locked — блокированы границы объекта; 

·  Others Locked — блокированы прочие свойства объекта. 

Снимая некоторые из этих опций, вы можете частично разблокировать объект. Если требуется разблокировать объект полностью, следует воспользоваться командой главного меню Edit > Unlock (<Ctrl> + <Shift> + <U>) или аналогичной командой контекстного меню секции треков. Перед разблокированием объекта его следует выделить. 
Стоит упомянуть об опции Lock Event Attributes, доступной в разделе Editing окна Preferences, вызываемого командой главного меню File > Preferences. 
По своей сути данная опция является списком, в котором можно выбрать, какие именно атрибуты будут блокироваться у объекта при применении команды блокирования. По умолчанию блокируются Position + Size + Other, т. е. все атрибуты объекта. 

4.5. Операции над треками

Можно перемещать не только графические объекты, расположенные на треках, но и сами треки. Делается это очень просто. В списке треков хватаетесь за поле нужного трека (рис. 4.57, а) и перемещаете его в вертикальном направлении. Вернее, сам трек остается на месте, а перемещается яркая горизонтальная полоса, указывающая на то место, куда будет перемещен трек (рис. 4.57, б). 
Если эта полоса зеленая, то перемещение возможно и произойдет сразу после того, как будет отпущена кнопка мыши (рис. 4.57, в). Если полоса красная, то перемещение трека в указанную позицию невозможно. Такая ситуация может возникнуть, если, например, вы захотите перетащить трек в ту же позицию, где он в данный момент находится. 
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Рис. 4.57. Перемещение трека
Само собою разумеется, что при перемещении полей в списке треков будут перемещаться и сами треки в секции треков. Трек всегда располагается напротив соответствующего ему поля в списке треков. 
Вообще, когда речь идет об операциях над треками, то связанные с этим команды удобнее выбирать в контекстном меню, вызываемом щелчком правой кнопки мыши на поле необходимого трека в списке треков. Перечислим такие команды: 

·  Duplicate Track — создать точную копию трека; 

·  Disable Track/Enable Track — включить/выключить трек. Информация с выключенных треков не воспроизводится, что приводит к снижению дисковой активности. Но если к треку в режиме вставки подключены плагины, то выключение трека не приведет к снижению нагрузки на процессор; 

·  Remove Track — удалить трек; 

·  Add Multiple Tracks — добавить несколько треков; 

·  Remove Selected Tracks — удалить выделенные треки (треков может быть несколько). 

Чтобы выделить несколько треков, следует "перещелкать" их поля в списке треков, удерживая нажатой клавишу <Ctrl>. Можно также выделить группу треков, удерживая нажатой клавишу <Shift>. Это стандартный для Windows способ выделения нескольких элементов. 
Давайте подробнее остановимся на команде Add Multiple Tracks. Если ее вызвать, появится диалоговое окно, показанное на рис. 4.58. 
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Рис. 4.58. Добавление нескольких треков
В списке Track следует выбрать тип добавляемых треков (MIDI, Audio, Group Channel). В поле Count нужно ввести количество добавляемых треков и нажать ОК. Эта простая процедура иногда позволяет сэкономить немного времени. 

4.6. Треки-контейнеры

С помощью треков-контейнеров (folder tracks) можно улучшить структуру проекта. Единственная функция треков-контейнеров — они могут хранить внутри себя другие треки. 
Давайте создадим трек-контейнер. Для этого можно воспользоваться командой главного меню Project > Add Track > Folder. Альтернативный способ — воспользоваться командой Add Folder Track из контекстного меню списка треков. Дополнительно создадим несколько треков для того, чтобы поместить их внутрь трека-контейнера. Рис. 4.59 иллюстрирует следующее: созданы MIDI-трек (MIDI 01), аудиотрек (Audio 01) и трек-контейнер (Folder); текущим выбран трек-контейнер, показано поле его инспектора. 
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Рис. 4.59. Создан трек-контейнер
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Рис. 4.60. Перемещение треков в контейнер
Давайте перетащим MIDI-трек внутрь трека-контейнера, используя метод Drag and Drop. Для этого ухватимся за поле перетаскиваемого трека в списке треков (рис, 4.60, а) в месте, свободном от атрибутов. Возникнет красная горизонтальная полоса. Удерживая левую кнопку мыши нажатой, перетащим полосу в центр поля трека-контейнера. Полоса должна превратиться в зеленую стрелку (рис. 4.60, б). Теперь кнопку мыши можно отпустить, и MIDI-трек окажется внутри трека-контейнера. Аналогичным образом перетащим второй трек внутрь трека-контейнера. Результат показан на рис. 4.61. 
И MIDI-, и аудиотреки расположены под треком-контейнером, а их поля в списке треков смещены относительно поля трека-контейнера вправо. В левой нижней части трека-контейнера расположен символ "—" (на рис. 4.61 на него указывает стрелка курсора мыши). Если на нем щелкнуть, содержимое трека-контейнера будет скрыто. Визуально в проекте будет присутствовать один трек-контейнер, остальные треки будут "спрятаны" внутри него. 
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Рис. 4.61. В контейнер помещены два трека
В поле инспектора трека-контейнера будет отображаться древовидная структура, соответствующая содержимому трека-контейнера (рис. 4.62, а). 
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Рис. 4.62. Инспектор трека-контейнера
В нашем примере дерево состоит всего лишь из корня (Folder) и двух "листьев" (MIDI 01 и Audio 01). Но, в принципе, мы могли бы вложить в трек-контейнер и другие треки-контейнеры, а в них, в свою очередь, тоже вложить треки-контейнеры. Тогда бы дерево было бы действительно ветвистым деревом (рис. 4.63). 
Если щелкнуть по названию одного из треков, вложенных в трек-контейнер (рис. 4.62, б), под полем инспектора трека-контейнера отобразится аналогичное поле соответствующего трека. 
Какая практическая польза от треков-контейнеров? Они позволяют сократить количество видимых треков в проекте и обеспечивают быстрый доступ к параметрам скрытых треков. Кроме того, у треков-контейнеров также имеются атрибуты: Mute, Solo, Record Enable и др. Изменение состояния этих атрибутов влечет за собой соответствующее изменение аналогичных атрибутов у всех вложенных треков. 
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Рис. 4.63. Иллюстрация возможности построения ветвистого дерева треков
4.7. Трек маркеров (Marker Track) и все, что с ним связано

С помощью маркеров можно пометить какие-либо временные позиции в проекте. Например, можно установить маркер в начале припева и присвоить ему имя "Refrain". В дальнейшем можно будет быстро переместиться в начало припева, щелкнув на соответствующем маркере, доступном в списке маркеров. 
Командой главного меню Project > Markers вызывается окно редактора маркеров Marker, показанное на рис. 4.64. 
С окном Marker удобнее всего работать, если оно всегда располагается поверх других окон. Чтобы закрепить его на поверхности экрана, следует щелкнуть правой кнопкой мыши на данном окне и в контекстном меню (содержащем всего один пункт) включить опцию Always On Top. 
Окно Marker содержит список всех маркеров, имеющихся в проекте. По умолчанию в любом проекте присутствует два особых маркера, имеющих идентификаторы (ID) L и R. Они уже известны вам как левый и правый локаторы. Удалить эти маркеры невозможно.
Новые маркеры в проект добавляются при помощи кнопки Add. Позиция нового маркера будет соответствовать указателю текущей позиции проекта. Идентификаторы новым маркерам присваиваются автоматически — это целые числа от 3 (числа 1 и 2 формально заняты левым и правым локаторами). Сразу после создания нового маркера станет доступным поле Description для ввода текста — обозначения маркера. Введите текст (например, "Refrain") и нажмите <Enter>. 
В дальнейшем для того, чтобы осуществить прыжок в позицию проекта, обозначенную маркером, следует щелкнуть на пустом поле, расположенном перед строкой нужного маркера в списке. Указатель текущей позиции проекта перейдет в позицию маркера (Position) и перед строкой маркера возникнет символ [image: image233.png]n



. Им помечается тот маркер, который в данный момент ближе всего расположен к указателю текущей позиции проекта. 
Однако мы описали не самый удобный способ перехода по маркерам (хотя бы из-за того, что окно Marker должно быть открыто). Первые девять идентификаторов маркеров (L, R, 1,2, 3, ... 9) соответствуют клавишам на цифровой клавиатуре (numeric keypad). Например, нажимаете клавишу <3> на цифровой клавиатуре, и указатель текущей позиции прыгает к маркеру с ID, равным 3. Причем не имеет значения, включен ли режим Num Lock или нет. Клавиша <0> закреплена за началом проекта: нажимаете ее и попадаете в начало проекта. В случае необходимости ID маркеров можно переназначить. Для этого следует сделать двойной щелчок на поле ID нужного маркера и ввести туда новое число. Если маркер с таким же ID уже существует, то ему будет присвоен исходный номер того маркера, ID которого вы заменяете. 
Переместить маркер можно, задав в поле Position новое его местоположение. Данное поле станет доступным, если сделать на нем двойной щелчок. 
Чтобы удалить маркер, надо щелкнуть на соответствующей ему строке в списке маркеров (маркер окажется выделенным) и нажать кнопку Remove. А если вместо кнопки Remove нажать кнопку Move, то выделенный маркер переместится в текущую позицию проекта. Это второй способ перемещения маркеров. 
Естественно, можно выделить сразу несколько маркеров. Делается это как обычно, с помощью клавиши <Ctrl> или <Shift>. 
Как следует из рис. 4.64, маркерами могут помечаться не только отдельные точки на оси времени, но и целые отрезки. Маркеры могут иметь конечную позицию (End) и, соответственно, длину (Length). Маркеры, имеющие продолжительность на оси времени, называются циклическими. В списке Show выбирается то, какие маркеры следует отображать: АН — все маркеры, Markers — обычные маркеры (не циклические), Cycle Markers — циклические маркеры. По умолчанию отображаются все маркеры. При этом, когда вы нажимаете кнопку Add, создаваться будут обычные маркеры. Чтобы создать циклический маркер, в списке Show следует выбрать Cycle Markers. Тогда при создании нового маркера кнопкой Add будет создаваться именно циклический маркер: его начало будет совпадать с позицией левого локатора, а окончание — с позицией правого. 
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Рис. 4.64. Окно редактора маркеров
Идентификаторы циклических маркеров — тоже числа, но они отображаются в квадратных скобках. Невозможно ассоциировать циклический маркер с клавишей на цифровой клавиатуре. Однако циклические маркеры лучше всего подходят для визуализации различных частей проекта (например, вступления, куплета, припева и т. п.). 
Для визуализации маркеров в окне проекта служит специальный трек — трек маркеров (marker track). В проекте может быть всего один такой трек. Создать трек маркеров можно командой главного меню Project > Add Track > Marker или командой Add Marker Track контекстного меню списка треков. 
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Рис. 4.65. Трек маркеров
На рис. 4.65 показаны все три элемента трека маркеров: инспектор, поле в списке треков и, собственно, сам трек с маркерами. 
Инспектор трека маркеров представляет собой не что иное, как окне Marker, рассмотренное выше. Поле инспектора даже так и называется Marker. 
Рассмотрим поле трека маркера в списке треков. Оно содержит три поля и три кнопки. Перечислим кнопки: 
[image: image236.png]


(Add Marker) — добавление маркера в текущую позицию проекта;
[image: image237.png]


(Add Cycle Marker) — добавление циклического маркера, начало и окончание которого будут соответствовать расположению левого и правого локаторов;
[image: image238.png]


— переключить способ представления времени: музыкальное или линейное. Аналогичные переключатели имеются у MIDI- и у аудиотреков. Три поля трека маркера в списке треков предназначены для подачи команд. Щелкаете на поле; открывается список, содержащий маркеры; выбираете маркер; выполняется связанная с этим маркером и полем команда. Перечислим поля: 

·  Locate — переместить указатель текущей позиции в позицию выбранного маркера; 

·  Cycle — переместить левый и правый локаторы в позиции начала и окончания циклического маркера; 

·  Zoom — изменить горизонтальный масштаб секции треков так, чтобы выбранный циклический маркер занимал всю видимую область. 

А теперь скажем несколько слов о том, как отображаются маркеры в секции треков, и о том, что с ними можно делать. 
Обычные маркеры отображаются в виде цветных вертикальных черточек. Около каждого из маркеров отображается или его ID, или его описание (Description), если таковое существует. Двойной щелчок на изображении маркера эквивалентен команде Locate. 
Циклические маркеры похожи на букву "Н": две вертикальные черточки (соответствующие началу и окончанию маркера), центры которых связаны горизонтальной линией. На рис. 4.65 циклический маркер имеет идентификатор 1 (или  в списке маркеров). Двойной щелчок на изображении циклического маркера эквивалентен команде Cycle. 
Вы можете добавлять новые маркеры с помощью карандаша, выделять одиночные маркеры или группы маркеров, перемещать их с помощью мыши, удалять их при помощи ластика. Одним словом, с маркерами можно делать все то же, что и с любыми другими графическими объектами. Хотя, пожалуй, имеются и отличия: например, вы не сможете копировать выделенные маркеры в буфер обмена, а команда Edit > Cut (вырезать в буфер обмена) на самом деле приводит к их удалению.

4.8. Автоматизация

Автоматизация — одна из важнейших функций Cubase SX, позволяющая сохранять, редактировать и воспроизводить изменения параметров микширования и эффектов. Во время записи автоматизации все ваши манипуляции с параметрами микширования (панорамирование, громкость и т. д.) и изменения параметров эффектов будут сохраняться на треках проекта в виде данных автоматизации. Данные автоматизации — специальные сообщения, описывающие изменения автоматизируемых параметров во времени. Им соответствуют графические объекты (узлы), определяющие форму огибающих автоматизации — графиков изменения автоматизируемых параметров во времени. 

4.8.1. Запись автоматизации

Немного практики. Выберите какой-нибудь трек. Неважно какой — MIDI-или аудиотрек. Включите для него атрибуты W (Write Enable) — разрешена запись автоматизации) и R (Read Enable) — разрешено воспроизведение данных автоматизации). Запустите проект на воспроизведение (именно на воспроизведение, а не на запись). Во время воспроизведения подвигайте какой-нибудь регулятор (или даже несколько регуляторов), например регулятор громкости или панорамы. Остановите воспроизведение, отмотайте проект в начало, вновь запустите воспроизведение. Регулятор, который вы двигали раньше, начнет повторять ваши движения, но уже без вашей помощи. Так работает автоматизация. Все ваши движения были сохранены в виде специальных данных и теперь воспроизводятся. На панели инструментов окна проекта имеется символ [image: image239.png]


. Справа от него расположен раскрывающийся список, в котором можно выбрать один из трех режимов записи автоматизации:

·  Touch Fader — запись автоматизации начинается сразу после того, как вы коснетесь какого-либо регулятора (захватите его курсором мыши), и прекращается сразу после того, как регулятор будет отпущен; 

·  Autolatch — запись автоматизации начинается сразу после того, как вы коснетесь какого-либо регулятора, и будет прекращена только после того, как вы выключите атрибут трека W (Write Enable); 

·  X-Over — запись автоматизации начинается сразу после того, как вы коснетесь какого-либо регулятора, и будет прекращена сразу после того, как записываемая огибающая автоматизации пересечет уже существующую огибающую автоматизации этого же параметра. 

По умолчанию выбран режим Touch Fader. Режим Autolatch полезно применять тогда, когда требуется "затереть" существующие данные автоматизации новыми. Режим X-Over полезен, когда требуется внести изменения в существующие огибающие автоматизации, но избежать при этом их резких скачков. 
Самый быстрый способ получить доступ к данным автоматизации трека — воспользоваться командой Show Used Automation контекстного меню, вызываемого щелчком правой кнопкой мыши на нужном поле трека в списке треков. Эта команда откроет подтреки, содержащие данные автоматизации. Если воспользоваться командой главного меню Project > Show Used Automation, то откроются все подтреки, содержащие данные автоматизации всех треков проекта. Если после вызова команды ничего не произошло — значит данные автоматизации отсутствуют (не были записаны, не были сформированы или были удалены). 
Вообще вернее было бы сказать, что подтреки не содержат данных автоматизации, а служат для их отображения и редактирования. 
В левом нижнем углу поля любого трека в списке треков имеется символ "+". Если на нем щелкнуть, то раскроется подтрек, предназначенный для хранения данных автоматизации. Символ "+" превратится в "—". Если теперь щелкнуть на нем — подтрек будет скрыт. 
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Рис. 4.66. Подтрек, содержащий огибающую автоматизации панорамы
Сам подтрек действительно располагается под треком, к которому он принадлежит. Его поле в списке треков немного смешено вправо относительно полей треков. Возможный вид подтрека с данными автоматизации показан на рис. 4.66. 
В нижней части поля подтрека имеется символ "+". щелкнув на котором, можно открыть еще один подтрек. У него, в свою очередь, также будет кнопка в виде "+". У одного трека может быть столько подтреков, сколько вам потребуется. Каждый из подтреков не является уникальным. Любой из подтреков может служить для отображения и редактирования данных автоматизации любого из параметров трека. Назначение подтрека переключается: в правой верхней части области подтрека в списке треков имеется поле, в котором отображается название параметра, на отображение данных автоматизации которого настроен подтрек. Щелчком на данном поле открывается меню, в котором перечислены основные параметры, подлежащие автоматизации, и специальные команды (рис. 4.67, а). 
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Рис. 4.67. Выбор параметра, подлежащего автоматизации
Выбрав один из параметров, вы тем самым переключите подтрек на отображение автоматизации данного параметра. Если около названия параметра в меню присутствует символ "*", то это означает, что для данного параметра существует автоматизация. Когда вы его выберете, на подтреке будет отображаться соответствующая огибающая, которая, по всей видимости, будет отличаться от горизонтальной прямой линии. 
Осталось упомянуть три специальные команды: 

·  More — открыть диалоговое окно Add Parameter (рис. 4.67, б), в котором перечислены все параметры, подлежащие автоматизации, а не только те, что перечислены в меню, показанном на рис. 4.67, а. 

·  Remove Parameter — скрыть подтрек и удалить данные автоматизации. Команда главного меню Edit > Undo (отмена последнего действия) при этом не действует!  

·  Remove Unused Parameters — скрыть все неиспользуемые подтреки, т. е. те подтреки, которые не отображают никакой автоматизации (она не была записана или сформирована). 

4.8.2. Формирование и редактирование огибающих автоматизации

Данные автоматизации представляются в виде тонких разноцветных линий, называемых огибающими. Вернее было бы сказать, что огибающие будут цветными в том случае, если для соответствующих подтреков включен атрибут R (Read Enable). Положение точки линии (по вертикали) соответствует значению автоматизированного параметра в текущей позиции проекта. Узловые точки огибающих обозначаются маленькими черными квадратиками. По своей сути огибающие автоматизации — это графики изменения автоматизируемого параметра во времени. Огибающая, имеющая вид прямой линии, означает отсутствие изменений автоматизируемого параметра во времени. 
Вы можете сформировать огибающую автоматизации нужной вам формы с помощью мыши. Однако сделать это возможно только в том случае, если для соответствующих потреков включен атрибут R (Read Enable). В противном случае с помощью мыши вы сможете перемещать горизонтальную прямую черную линию, высота которой соответствует значению параметра. Однако говорить об автоматизации данного параметра здесь уже нельзя. Перемещая эту линию, вы изменяете его статическое значение, которое будет оставаться неизменным при воспроизведении проекта. 
Итак, если это необходимо, включите атрибут R (Read Enable) и попробуйте вместе с нами сформировать огибающую автоматизации какого-либо параметра (например, панорамы). Еще одно необходимое для этого условие — вы должны пользоваться инструментом [image: image242.png]


(Object Selections), который вам уже хорошо знаком.
На подтреке бледным цветом отображается содержимое основного трека: MlDI-сообщения (в виде черточек) или волновые формы аудиосообщений (рис. 4.68, а). По умолчанию огибающая имеет вид горизонтальной линии. Чтобы "переломить" эту линию, в месте перелома следует создать узел. В свою очередь, для того чтобы создать узел, следует подвести курсор мыши как можно ближе к огибающей автоматизации и выполнить щелчок. Узел возникнет в виде маленького квадрата (скорее, даже в виде жирной точки). Как и любой другой графический объект, узел может находиться в двух состояниях: он может быть выделен (для совершения каких-либо операций над ним) или не выделен. Сразу после создания узел имеет статус выделенного и окрашен в красный цвет. Однако как только вы создадите еще один узел (рис. 4.68, б), первый потеряет статус выделенного и сменит красный цвет на черный. Давайте попробуем переместить вновь созданный узел (рис. 4.68, в). Понятно, что для этого следует ухватиться за него мышью и тянуть в нужном направлении. При этом около курсора будет отображаться подсказка с координатами узла: одна координата — позиция на шкале времени (в нашем примере — это 5.1.1.), другая — значение автоматизируемого параметра в точке узла (в нашем случае автоматизации подлежит панорама, значение панорамы — L 48). 
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Рис. 4.68. Формирование огибающей автоматизации
Сформируем еще один узел огибающей автоматизации (рис. 4.68, г). При включенном режиме привязки графических объектов [image: image244.png]


(Snap) возможные координаты узлов в полной степени зависят от ограничений, накладываемых данным режимом. Естественно, речь идет только о координатах на оси времени.
Если вы будете внимательны, то заметите, что огибающая перед первым и последним узлами имеет вид горизонтальной линии. Изменение автоматизируемого параметра будет происходить только на отрезках между узлами. К сожалению, в Cubase SX интерполяция значений параметра между узлами огибающих осуществляется только прямыми линиями (линейная интерполяция). Например, в музыкальном редакторе SONAR интерполяция узлов огибающих может осуществляться линиями различного вида. Благодаря этому можно описать огибающую сложной формы небольшим количеством узлов, что существенно облегчает ее редактирование. В Cubase SX для описания огибающей сложной формы потребуется большое количество узлов. Если возникнет необходимость немного изменить форму огибающей, то для этого придется поочередно передвигать все узлы, из которых она состоит. А каждый из узлов может передвигаться только в пределах, ограниченных соседними узлами. Поэтому для формирования сложной огибающей удобнее использовать инструмент[image: image245.png]


 (Draw): вы просто рисуете огибающую курсором мыши, словно карандашом. Сам курсор при этом как раз имеет вид карандаша [image: image246.png]


Следует обратить внимание на одну деталь. Когда вы рисуете огибающую с помощью инструмента [image: image247.png]


  (Draw) или осуществляете запись автоматизации, формируется огромное количество узлов, в точности описывающих ваши движения (рис. 4.69, а). Как только вы прекратите запись или рисование огибающей, значительное количество узлов исчезнет (рис. 4.69, б). Как раз для того чтобы сделать редактирование формы огибающей осуществимым на практике, программа произведет прореживание узлов. При этом огибающая в целом сохранит свою форму, но мельчайшие подробности исчезнут. 
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Рис. 4.69. Запись автоматизации
За прореживание узлов отвечает специальный параметр, называемый Automation Reduction Level. Чтобы получить доступ к нему, вызовите команду главного меню File > Preferences. Возникнет окно Preferences, в котором следует выбрать раздел Editing. Глубина прореживания определяется положением регулятора Automation Reduction Level. 
Несколько облегчить жизнь в ряде случаев может набор инструментов. скрывающихся за кнопкой [image: image249.png]


;
(Draw), расположенной на панели инструментов окна проекта. С их помощью вы можете легким движением руки формировать огибающие относительно сложных форм. Перечислим их: 
[image: image250.png]


(Line) — отрезок прямой линии;
[image: image251.png]


(Parabola) — линия параболической формы;
[image: image252.png]


(Sine) — линия синусоидальной формы;
[image: image253.png]


(Triangle) — линия периодической треугольной формы;
[image: image254.png]


(Square) — линия периодической прямоугольной формы.
Если не включены режимы [image: image255.png]


(Snap) и Grid (в поле Snap Mode Selector на панели инструментов окна проекта), тогда длительность периода синусоиды, волн треугольной и прямоугольной форм равна одному музыкальному такту. В том случае, когда длительность периода нужно изменить, включите перечисленные режимы и задайте длительность, выбрав соответствующие режимы в полях Grid Selector и (если требуется) Quantize Selector. В качестве примера создадим огибающую в форме параболы, для чего воспользуемся инструментом [image: image256.png]


(Parabola). Подведем курсор мыши к началу параболического участка огибающей, нажмем левую кнопку мыши и переместим курсор мыши в ту позицию, которая будет соответствовать окончанию формируемого участка (рис. 4.70, а). Сам курсор при этом будет иметь вид [image: image257.png]


. Будущая форма огибающей будет показана темно-серой линией. 
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Рис. 4.70. Создание огибающей в форме параболы
Как только вы отпустите кнопку мыши, огибающая параболической формы будет создана (рис. 4.70, б). При этом будет использован механизм прореживания узлов. В нашем случае "парабола" описана четырьмя узлами. Возможно выполнение операций над группами узлов. Нужные узлы следует выделить с помощью инструментов [image: image259.png]


(Object Selections) или [image: image260.png]


(Range Selections). Затем можно ухватиться за один из выделенных узлов и перетащить всю группу. Выделенные узлы можно копировать или вырезать в буфер обмена. Впоследствии их можно будет вставить в текущую позицию проекта. Выделенные узлы можно удалить, нажав клавишу <Delete>. Автоматизация параметров треков разных видов и плагинов имеет свои особенности. Их анализу посвящены следующие разделы.

4.8.3. Автоматизация MIDI-треков

У MIDI-треков автоматизации подлежат следующие параметры: 

·  Volume — громкость MIDI-трека; 

·  Pan — панорама MIDI-трека; 

·  Mute — мьютирование MIDI-трека; 

·  Send 1 Enable — Send 4 Enable — включение/выключение посылов на MIDI-эффекты параллельного действия; 

·  Track Parameters on/off switch — включение/выключение всех алгоритмов обработки MIDI-сообщений, управляемых из секции Track Parameters инспектора MIDI-трека; 

·  Insert 1 Enable — Insert 4 Enable — включение/выключение MIDI-эффектов последовательного действия; 

·  Transpose — транспонирование высоты звука;  

·  Vel. Shift — смещение параметра Velocity;  

·  Random 1-2 Min/Max/Target — параметры рандомизации; 

·  Range 1-2 Min/Max/Target — параметры алгоритма Range;  

·  Параметры MIDI-эффектов последовательного действия;  

·  Параметры MIDI-эффектов параллельного действия.  

Параметры MIDI-эффектов будут доступны для автоматизации в том случае, если соответствующие эффекты подключены к MIDI-треку. На первый взгляд перечень параметров, подлежащих автоматизации, может показаться скромным. Как, например, автоматизировать MIDI-контроллеры, отличные от Volume и Pan? В вашем распоряжении имеется множество MIDI-эффектов, включая эффект Control. С его помощью можно управлять любыми MIDI-контроллерами. А значения параметров данного эффекта (т. е. MIDI-контроллеры) подлежат автоматизации. Пример: требуется построить огибающую для управления MIDI-контроллером Brightness (№74 — управление частотой среза фильтра). Наши действия: 
1. В секции Inserts инспектора MIDI-трека подключаем эффект Control (рис. 4.71, а). 
2. В качестве одного из параметров данного эффекта, например, вместо BankSel MSB (рис. 4.71, б), выбираем Brightness (рис. 4.71, в). 
В результате, MIDI-контроллер Brightness (№74) становится доступным для автоматизации (рис. 4.72). 
Хотим обратить ваше внимание на одну деталь. Допустим, вы автоматизируете параметр Pan. В каком виде будут сохраняться данные автоматизации на MIDI-треке? Можно было бы предположить, что автоматизация данного параметра будет записана посредством MIDI-сообщений Controller №10 (Pan). 
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Рис. 4.71. Подключение MIDI-эффекта Control и выбор MIDI-контроллера Brightness (74) для последующей автоматизации
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Рис. 4.72.Автоматизация MIDI-контроллера Brightness (74)
В действительности любая автоматизация в Cubase SX сохраняется в виде специализированных сообщений. Эти сообщения отражают расположение узлов на графиках, описывающих изменения автоматизируемых параметров во времени. Конечно же, при воспроизведении данных автоматизации, в конечном счете, MIDI-устройству (синтезатору, сэмплеру и т. д.) будут передаваться именно MIDI-сообщения. Но формироваться они будут "на лету": программа знает, как расположены узлы графиков, интерполирует их, в нужные моменты времени посылает на выходные порты MIDI-треков соответствующие MIDI-сообщения об изменении положений MIDI-контрол-леров. В то же время внутри MIDI-частей могут храниться серии сообщений типа Controller, которые, в принципе, могут вступать в конфликт с данными автоматизации. Пример: данные автоматизации описывают перемещение инструмента на панораме из центра вправо, и в то же время на треке хранится последовательность MIDI-сообщений, описывающая перемещение инструмента на панораме из центра влево. Что мы реально при этом услышим? Поскольку MIDI-сообщения, формируемые на основании данных автоматизации, и MIDI-сообщения, воспроизводимые с трека, будут посылаться в разные моменты (хотя бы потому, что интерфейс MIDI является последовательным), возникнет "дрожание" контроллера (в нашем случае панорамы). Панорама будет "метаться" слева направо и наоборот десятки раз в секунду.

4.8.4. Автоматизация аудиотреков и групповых треков

У аудиотреков и групповых треков автоматизации подлежат следующие параметры: 

·  Volume — громкость трека; 

·  Pan Left-Right — панорамирование по оси влево-вправо; 

·  Pan Front-Rear — панорамирование по оси вперед-назад (для системы объемного звучания); 

·  Mute — мьютирование трека; 

·  EQ Master Bypass — временное отключение трекового эквалайзера; 

·  FX Send Bypass — временное отключение посылов на эффекты параллельного действия; 

·  параметры каждого из четырех фильтров эквалайзера; 

·  включение/выключение каждого из восьми посылов; 

·  уровень каждого из восьми посылов; 

·  переключение pre/post для каждого из восьми посылов; 

·  параметры панорамирования системы объемного звучания; 

·  переключение пресетов для эффектов последовательного действия; 

·  параметры эффектов последовательного действия. 

4.8.5. Автоматизация VSTi и аудиоэффектов, мастер-секции микшера

Автоматизировать параметры виртуальных инструментов VSTi можно двумя способами. Первый способ заключается в использовании "стандартных" возможностей автоматизации MIDI-треков для управления параметрами виртуальных синтезаторов VSTi. Из документации на программный синтезатор можно узнать, какими MIDI-контроллерами управляются нужные параметры, и воспользоваться методикой, описанной в разд. 4.7.5, для автоматизации этих параметров с помощью MIDI-плагина Control.
Однако второй способ автоматизации VSTi гораздо удобнее первого. Ведь спецификация VSTi изначально разрабатывалась для интеграции программных синтезаторов в проект Cubase. Это означает, что после подключения к проекту, VSTi становится как бы его частью. В Cubase SX предусмотрен специальный трек для хранения данных автоматизации всех VSTi, задействованных в проекте (VST Instrument Automation). В проекте такой трек может быть только в единственном экземпляре. Данный трек фактически является контейнером для треков, содержащих автоматизацию параметров различных VSTi — каждому VSTi соответствует по одному такому треку. У каждого из этих треков в свою очередь также могут быть подтреки, содержащие данные автоматизации различных параметров этого VSTi. 
Однако специальной команды, создающей данный трек, не существует. Как же быть? В верхней части панели каждого из VSTi имеется набор стандартных для плагинов Cubase SX органов управления. Среди них имеются знакомые вам кнопки R (Read Enable — воспроизведение данных автоматизации) и W (Write Enable — запись данных автоматизации). Первое нажатие кнопки W — это и есть команда создания трека-контейнера VST Instrument Automation и трека автоматизации конкретного VSTi. Все вышеизложенное может показаться запутанным, но на практике все обстоит очень просто. В разд. 4.1.3 мы рассказали о том, как VSTi подключаются к проекту. В качестве примера мы задействовали инструмент a1. Теперь давайте создадим трек для автоматизации параметров его синтеза. 
Исходные данные: к проекту подключен VSTi a1, один из MIDI-треков настроен на работу с данным инструментом (в качестве выходного порта выбран a1). В основной секции данного MIDI-трека нажмем кнопку е для того, чтобы вызвать появление панели инструмента a1 (рис. 4.73). 
Напомним, что вызвать панель VSTi можно и по-другому (посредством команды главного меню Devices > VST Instruments и окна диалога VST Instruments). Все, что нам требуется проделать в данном примере, — нажать кнопку W на панели инструмента. На рис. 4.73 к этой кнопке подведен курсор. 
Сразу после этого в списке треков возникнут поля трека-контейнера VST Instrument Automation и трека автоматизации a1 (рис. 4.74). Кнопку R также не помешает нажать (чтобы записанные или сформированные в дальнейшем данные автоматизации воспроизводились). 
Дальше возможны два варианта. Вариант первый — запускаем проект на воспроизведение и вращаем различные ручки на панели VSTi. Все действия будут сохранены в виде данных автоматизации. Вариант второй — формируем огибающие автоматизации для нужных параметров. Щелчком на поле Unknown (рис. 4.74) вызываем список параметров конкретного VSTi, подлежащих автоматизации, выбираем нужный параметр, формируем огибающую. 
Если нужно автоматизировать еще один параметр, щелкаем на символе "+" в левом нижнем углу поля автоматизации VSTi — откроется еще один под-трек. У него, в свою очередь, тоже будет доступно поле с символом "+" То есть можно открывать столько подтреков, сколько нужно. 
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Рис. 4.73. Панель виртуального синтезатора а1
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Рис. 4.74. Поле трека автоматизации а1 в списке треков
Ответьте на контрольный вопрос. Допустим, вы подключили еще один VSTi и хотите его автоматизировать. Как создать соответствующий трек? Правильно, нужно открыть панель данного инструмента и нажать кнопку W. 
На всякий случай заметим, что инспектор трека-контейнера Devices > VST Instruments содержит список треков автоматизации VSTi. А сами треки автоматизации VSTi поля инспектора просто не имеют. 
Поговорим об автоматизации параметров аудиоэффектов. Если эффект подключен к аудиотреку в качестве эффекта последовательного действия (в секции Inserts инспектора аудиотрека), то все его параметры будут доступны для автоматизации в рамках данного трека. Но ведь в проекте могут использоваться и эффекты параллельного действия (подключенные в окне VST Send Effects, вызываемом командой главного меню Devices > VST Send Effects), которые не ассоциируются ни с одним из аудиотреков. Как их автоматизировать? В данном случае имеется полная аналогия с автоматизацией VSTi: нажимаете кнопку W на панели аудиоэффекта, автоматически создается трек-контейнер Effect Automation и трек автоматизации данного эффекта. Можете записывать свои манипуляции с параметрами эффекта во время воспроизведения проекта, можете формировать огибающие автоматизации — на ваше усмотрение. 
Тема данного раздела была бы не раскрыта, если бы мы не рассказали об автоматизации мастер-секции микшера Cubase SX. Однако нам придется немного забежать вперед и вкратце рассказать о том, что же представляет из себя мастер-секция микшера. Как вы знаете, у каждого аудиотрека или группового трека имеется выходной порт. Для нескольких аудиотреков или групповых треков может быть задан один и тот же выходной аудиопорт. Поэтому можно говорить о том, что выходные аудиопорты по своей сути являются шинами — на них объединяются сигналы от разных треков. Кстати, по умолчанию стереопары выходных портов так и называются BUS 1, BUS 2 и т. д. (bus — шина). На эти же шины осуществляется вывод сигналов, возвращаемых после обработки эффектами параллельного действия. Аудиотре-ки и групповые треки соответствуют линейкам виртуального микшера Cubase SX. Кроме всего прочего, в данном микшере имеется мастер-секция. В мастер-секции собраны все шины (выходные порты). Поэтому имеется возможность управлять общей громкостью всех аудиотреков, групповых треков и VSTi, используемых в проекте. Кроме того, к мастер-секции могут быть подключены аудиоэффекты последовательного действия. Все это нужно для осуществления мастеринга  непосредственно с помощью Cubase SX и VST-плагинов. 
В дальнейшем вы увидите, что на мастер-секции микшера также имеются кнопки R (Read Enable — воспроизведение данных автоматизации) и W (Write Enable — запись данных автоматизации). Первое нажатие кнопки W является командой создания специализированного трека-контейнера Master Automation. Этот трек-контейнер предназначен для хранения треков с данными автоматизации следующих параметров: 

·  громкость каждой из шин в отдельности (BUS Volume); 

·  общая громкость (Master Gain); 

·  общие уровни посылов на эффекты параллельного действия, подключаемые в окне VST Send Effects (Effect Input Level). 

4.9. Атрибуты объектов проекта, поле Infoline

На панели инструментов окна проекта имеется кнопка [image: image265.png]


(Show Event Infoline). Если ее включить, под панелью инструментов возникнет информационное поле Infoline, отображающее значения основных атрибутов выделенной части или аудиосообщения (рис. 4.75). 
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Рис. 4.75. Поле Event Infoline
Альтернативный способ показать или скрыть данное поле — воспользоваться командой контекстного меню секции треков или поля инспектора Show Info/Hide Info. 
Все атрибуты, отображаемые на панели Infoline, доступны для редактирования. Причем редактировать их на данной панели в ряде случаев удобнее, чем какими-либо другими путями. 
Перечислим атрибуты, доступные для MIDI-части: 

·  Name — название части; 

·  Start — позиция начала части; 

·  End — позиция окончания части; 

·  Length — длина части; 

·  Offset — смещение левой границы части относительно ее начального положения; 

·  Mute — атрибут мьютирования; 

·  Lock — атрибуты блокирования части; 

·  Transpose — транспонирование в полутонах. 

Набор атрибутов части, содержащей аудиосообщения, будет отличаться от описанного выше отсутствием атрибута Transpose. 
А набор атрибутов аудиосообщения будет отличаться существенно: 

·  File — название звукового файла; 

·  Description — описание аудиосообщения; 

·  Start — начальная позиция; 

·  End — конечная позиция; 

·  Length — длительность аудиосообщения; 

·  Offset — начало аудиосообщения, которое задается в виде смещения относительно начала звукового файла; 

·  Snap — реперная точка; 

·  Volume — громкость аудиосообщения; 

·  Fade In — длительность фазы нарастания громкости; 

·  Fade Out — длительность затухания громкости; 

·  Mute — мьютирование; 

·  Lock — атрибуты блокирования аудиосообщения. 

Особо хочется выделить параметр Snap. Дело в том, что в каждом звуковом сообщении имеется специальный маркер, который определяет смещение особой опорной точки относительно начала клипа. По умолчанию она совпадает с началом аудиосообщения, но может располагаться и внутри него. 
При перемещении аудиосообщения привязка (см. разд. 4.4.4) будет осуществляться именно к этой точке, а не к его началу. Параметр Snap определяет положение опорной точки на оси времени. Если значение Snap отличается от Start, то опорная точка не совпадает с началом аудиосообщения. 
Атрибуты узлов огибающих автоматизации (которые по своей сути тоже являются сообщениями): 

·  Туре — автоматизируемый параметр;  

·  Start — позиция узла на оси времени; 

·  Value — значение автоматизируемого параметра в точке узла (высота узла на графике). 

Атрибуты имеются абсолютно у всех объектов проекта, включая видеофайлы, которые могут быть импортированы в проект командой главного меню File > Import > Video File. Однако нет особого смысла их перечислять.

